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Know Your sensorProbe 

What is sensorProbe? 

Introduction 

 

The standalone sensorProbe® is an intelligent device for monitoring 

environmental variations, power, physical threats and security. The sensorProbe 

is a completely embedded host with a proprietary Linux like Operating System, 

including TCP/IP stack, Web server, email, SMS and full SNMP functionality.  

 

The sensorProbe works with every intelligent sensor in the AKCP family. You can 

connect any of our sensors in any combination to monitor temperature, humidity, 

water leakage, Airflow including long term graphing, security; detect AC Power 

Line Voltage, Measure DC Voltage, control relays, and many more. Our sensors 

include an integrated data collection and graphing package to spot trends in the 

airflow, temperature, and humidity. 

 

Dry contacts and drivers are available for monitoring UPS status, security 

systems, and air conditioning status. 

 

Every sensor comes with our unique Autosense feature. Whenever a new type of 

sensor is plugged in, the Autosense will recognize it and reconfigure the 

sensorProbe to begin monitoring it. In the event of an alarm or temperature / 

humidity threshold being exceeded, it has ability to send alert notification using 

Email, SMS and SNMP Traps. 

 

The sensorProbe’s advanced encrypted micro code updating program can 

update your firmware over the internet. 
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A new web based interface with a user and administrator login feature helps 

users to prevent unauthorized access to the device and a powerful embedded 

system logging features is available. 

 

The sensorProbe is fully SNMP compliant and configurable. Following initial 

configuration by the RJ45 port to set basic parameters such as IP address, 

Subnet Mask, Default gateway, SNMP community strings, trusted IP addresses 

and trap destinations, the unit is fully configurable from any SNMP terminal or 

Network Management product. Setup is easy with the embedded web server. 

There is a simple graphing utility integrated into the sensorProbe which can 

monitor every temperature, humidity sensor and other such factors and can 

display you the graphical report. 

 

The sensorProbe is supplied with a MIB to allow its interface to SNMP based 

Network Management systems such as HP Open View, IBM Tivoli, CA Unicenter 

TNG and others. 
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Installation 

Installation Steps 
The sensorProbe is a plug n play device you can easily connect to your existing 

network set up.  Every sensorProbe has a factory default IP address, 

192.168.0.100; you can change this address if so needed for your network 

configuration. 

 

Ensure the following items are available with you before installing the 

sensorProbe 

 

1. A crossover CAT 5 network cable with RJ 45 male connector  

2. A PC with an Ethernet card installed and configured. (You can also plug 

sensorProbe into your LAN) 

3. A Power socket to plug in the sensorProbe 

4. You can also assign IP address using the web based user interface of the 

sensorProbe.  Open any web browser such as IE, type the factory default IP 

address, (192.168.0.100) and from the Network page you can enter a new IP 

address and click Save button. Use a crossover cable connection to perform this 

step. 

 

An overview of the installation process consists of:  

1. Assign a new IP address to the sensorProbe.  

2. Use the embedded web manager to set sensor thresholds, email and trap 

information.  

3. Use your management station or SNMP script to collect information from the 

sensorProbe.  
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Assigning a New IP address 

The sensorProbe has a 10 Megabits per second (Mbps) Ethernet LAN. It uses 

one standard RJ-45 connector. To set up the sensorProbe you must connect it to 

the network by plugging in the RJ-45 connector. 

 

The sensorProbe can have its IP address assigned in two ways. The first way is 

to statically assign an IP address. The second method is to use DHCP; this 

stands for Dynamic Host Configuration Protocol. This method requires you to 

have a DHCP server. 

 

1. Statically Assigning the IP Address. 

Static IP Addresses are often used in equipment such as routers and other 

network equipment. This is the simplest and most often used method. Once a 

static assignment of an IP address is made, it never changes. All changes to the 

IP address are saved to a nonvolatile flash memory and retain their values even 

if power is lost.  

 

2. Assigning the IP Address using DHCP. 

The sensorProbe is shipped with DHCP disabled. You must first enable this 

using either SNMP or the web interface. The sensorProbe is shipped with the IP 

address 192.168.0.100.  You may have to set up the routing table on the PC to 

be able to reach the sensorProbe. To learn more about setting up the routing 

table please go here.  

 

To use the web interface, press the Network Tab, select Use DHCP from Use 

DHCP field and then press Save. 

 

With DHCP the sensorProbe puts out a request to the DHCP server to be 

assigned an IP address. This is a broadcast message and is forwarded by 
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routers to the DHCP server. The DHCP server responds by sending the 

sensorProbe a new IP address and a lease period.  

 

When the lease period reaches the renew time, which is normally one half of the 

lease period the sensorProbe will send a message to the DHCP server that 

loaded it to renew its lease. If the server responds, then the lease is renewed for 

a period of time chosen by the DHCP server.  

 

If the DHCP server does not respond the sensorProbe periodically resends the 

request until the rebind period which is normally 7/8 of the lease period. At this 

time the sensorProbe puts out a broadcast message for any DHCP server in the 

enterprise. If the server responds, then the lease is renewed. If the server does 

not respond then at the end of the lease the sensorProbe will voluntarily take its 

IP address off of the network while continuing to periodically broadcast a request 

to any DHCP server.  

 

If the sensorProbe has a static IP address assigned it will no longer send out 

DHCP requests. If you later wish to turn DHCP back on you can do that using the 

Web based interface.  

 

Caution: In order to assign the IP address, the sensorProbe needs to be on the 

same LAN as the computer that is assigning the IP address. If the sensorProbe 

is on the other side of a router, the router will change the MAC address and this 

method will not work. The surest way is to use a crossover cable on the local 

computer; however, you can also use most hubs to connect to the sensorProbe. 

 

Go to: Steps to assign a new IP address 
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Steps to Assign IP Address 

Using IPSet.exe and Quickstart Guide 

The CD you have received with the sensorProbe comes with a program called 

IPSet.exe. The IPSet.exe program is designed to run on a Microsoft host.  The 

program can operate in two modes: 1) Automatically Get IP and 2) Manually Set 

IP.  The program starts by automatically getting IP as a default operating mode. 

 The program listens for the currently assigned IP and MAC addresses.  The 

sensorProbe broadcasts its IP and MAC address when it is reboot.  Thus, after 

the IPSet.exe is running, cycle the sensorProbe power.  The IPSet.exe then 

receives the broadcasting IP and MAC addresses from the sensorProbe.  When 

the addresses appear in the window, you can press the green Setup Your 

sensorProbe button on the top; this will open a Quickstart Guide on a web 

browser and let you configure your sensorProbe. 

 

You can select to set IP address manually by changing to "Manually Set IP" 

mode.  Once the program has started enter the MAC address in the section 

labeled "MAC Address". The Mac address can be located on the sticker on the 

sensorProbe. Next enter the IP address that you wish to assign to the 

sensorProbe. Then press a "Set" button.  

 

IPSet.exe first checks the IP address to see if it already assigned. Next it will 

assign the IP address and then it will check that the address was successfully 

assigned. If all is well, then IPSet.exe will report that the assignment is Complete. 

 And, you can press the green Setup Your sensorProbe button on the top to 

open a Quickstart Guide on a web browser and let you configure your 

sensorProbe. 

 

Using a Web Interface to assign the IP address 

The sensorProbe is shipped with the IP address 192.168.0.100.  You can enter 

this IP address into your web browser and use the interface to change the IP 
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address.  However, before you can load the web interface page, you usually 

have to set up the routing table in the host computer*. This is because the IP 

address 192.168.0.100 is probably on a different subnet than the PC. In the 

usual case, the PC will try to connect to 192.168.0.100 using the default 

gateway, which is not what you want. 

 

*To set up the routing table, open a DOS window and at the command prompt 

enter. 

>route add 192.168.0.100 10.1.1.20 

 

Where 10.1.1.20 is the IP address of the ethernet interface that the sensorProbe 

is plugged into using the crossover cable. Now ping 192.168.0.100 to see if the 

connection was successful. 

 

For example, enter http://192.168.0.100 into the URL of the web browser and hit 

Enter key. 

Once the page has loaded, you can statically assign the desired IP address, by 

pressing the Network tab, entering a new IP address for the sensorProbe, and 

then pressing the Save button. 

 

Testing the new IP Address 

You have now assigned your sensorProbe a new IP address. You can check that 

this is the case by using ping or a web browser. Whenever a new IP address is 

assigned to a sensorProbe, that new IP address is saved in a nonvolatile flash 

memory. This means that the sensorProbe will retain its new IP address even 

after power is recycled. You can test that is the case by cycling power to the 

sensorProbe.  
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Quickstart Guide 

Quickstart Guide 
The Quickstart guide is the initial system for setting up your sensorProbe.  You 

will be led through the basic configuration of the sensorProbe by following these 

steps. 

 

The Quickstart guide appears on a web browser after the button Setup Your 

sensorProbe on IPSet.exe program is pressed.  Enter your Administrator 

password in the password field (the factory default password is public), and then 

press the Login button.  Now you have arrived at the Network Settings page. 

 Shown on this page are IP address, Subnet mask, and Default gateway fields; 

these are factory (default) values.  All these fields are now open (writeable) to 

change to suit your network configuration. 

 

After designating the correct numbers to the fields, press Save, the page will now 

change to show Network Settings is Successful.  Under this are four buttons, 

Summary, Setup Traps, Setup Mail, and Setup System; this gives you a 

choice of where to go on the sensorProbe Web Interface.  Once the button is 

pressed, a web browser loads the page of the web interface you selected.  You 

may choose to go to the Summary page, from this page all the others are 

accessible by clicking on the tabs on the top of the page. 
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Setup Traps 

The sensorProbe can send an SNMP trap message to two different hosts. 

 Whenever the status changes for a sensor that is online, a trap message can be 

sent. 
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Setup Mail 

The sensorProbe can send email to any SMTP server whenever the status 

changes for a sensor that is online. 
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Setup System 

This takes you to the System Settings page where you can configure 

information such as name, location, contact person, time and date, password, 

etc. 
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Intelligent Sensors 

Intelligent Sensors 
You can use any of our intelligent sensors with the sensorProbe2 and 

sensorProbe8 family.  

 

Installing and Configuring the Intelligent Sensors 

A/D Converter Calibration 

 

The following intelligent sensors are available : 

 

Temperature sensor 

Single Port Temperature/Humidity Sensor 

Water Detector 

Airflow Sensor 

AC Voltage Detector 

DC Voltage Sensor 

Security Sensor 

Dry Contact Sensor 

10 Dry Contact Inputs on the sensorProbe2 

Relay Operation 

Sensor Controlled Relay 

4-20mA Converter 

Smoke Detector 

Motion Detector 

External Sensor 
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Installing and Configuring Sensors 

Installing the sensors 

Simply open a web browser, plug in the sensor, and the device will automatically 

configure itself. The sensorProbe will recognize the sensor and begin monitoring. 

 

Navigating the interface 

Choose the page titled Sensors. On the left hand side of the Sensors page is a 

list of the different types of sensors. Click on the type of sensor and your sensor 

will appear with its port number. Click on the sensor that you want and you will 

open the Sensor settings screen. 

 

Hint : After you plug in the sensor and then refresh the summary screen, your 

sensor will automatically appear in the list of online sensors. If you click on the 

link under the type column you will be taken immediately to the Sensor settings 

screen. 

 

Entering data 

To enter new data in the data fields simply locate the cursor and type, after you 

press Save, the web page will be refreshed with the new data. Once you see the 

new data on the web page that indicates the data has been accepted by the 

sensorProbe. The sensorProbe will have saved this data to nonvolatile memory 

and it will be protected in case of power failure. 

 

Sensor status color indicator 

The colors red, orange and green indicate at a glance the status, red is critical, 

orange is warning, and green is in the normal field.  

 

 

 

 



sensorProbe 

14 

Disable Autosense 

You can disable the Autosense for any port by clicking on Autosense Setting at 

the bottom left of the Sensors page. Use the listbox to pick either Enable or 

Disable the Autosense for a particular port, and then click the Save button. 

 

 

Configuring the sensors 

 

Description : The description identifies this sensor and appears in several 

places. The description of the sensor appears in the summary page when this 

sensor is online. The description field is also included in traps and Email for this 

sensor so that you can identify the reporting sensor.  

Example description for a temperature sensor: Temperature for Computer Room. 

 

Status : The Status field shows the current status of the sensor. When the 

sensor is offline the status is noStatus. When the sensor is online the possible 

status values are Normal, Critical High, Warning High, Warning Low, Critical 

Low, and sensorError. 

 

When the sensor is online the status is formed by comparing the reading from 

the sensor to the thresholds. In the case of a switch the status is formed by 

comparing the value from the sensor with the Normal State. It is recommended 

that they not be set too narrow as this may cause unneeded messages to be 

generated. 

 

Online : This is a read only field that can either be online or offline. When the 

sensor is offline, the status is not updated.  

 

Go Online : You place the sensor online or offline by setting this field. Use the 

single choice list box to pick either Online or Offline. Press the Save button below 
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to implement your choice.  It may be convenient to take a sensor offline if it is 

reporting a large number of errors.  

 

Critical High, Warning High, Warning Low, Critical Low : These thresholds 

are compared to the sensor value several times a second, and the status is set 

accordingly. Some sensors such as the temperature and humidity sensors use 

these thresholds, whereas other sensors such as dry contact inputs only use the 

Normal State to formulate the status.   

 

Rearm : The Rearm parameter is useful for sensors whose values can vary such 

as the temperature and humidity sensor. 

 

The Rearm is used to prevent the sensor from flickering between two states. For 

example if the Warning High threshold for the temperature sensor is set to 80 

degrees and the sensor were to vary between 79 and 80 you could be faced with 

a very large number of emails, traps, and events logged. The Rearm parameter 

prevents this by forcing the temperature to drop by the Rearm before changing 

the state back to normal. In this example, if Rearm is set to 2 then the sensor 

would have to drop from 80 down to 77 before the status would change from 

Warning High back to normal.  

 

Sensor Controlled Relay 

 

This section describes the parameters used for configuring the sensor to take 

advantage of the automatic response feature of the Sensor Controlled Relay. 

 

Note: Before going further, it is recommended that you read the Relay Operation 

topic. 

 

This Sensor Controls the Relay on Port : Select the port number where the 

relay, which this sensor will control, is online.  Each number listed in this list box 
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includes the description of the sensor that is online on that port.  This helps 

prevent you from selecting the wrong port number.  If no relay should be 

controlled by this sensor, select "None" for this field. 

 

When the sensor goes : When the sensor status reaches the selected status 

shown in the list box, the relay performs action chosen in the relay action field 

(the second list box on this line).  The status chosen in the first list box is called 

"Relay-Activating Threshold".  There are five possible options: "High Critical", 

"HighWarning or High Critical", "Low Warning or Low Critical", "Low Critical", and 

"Any Error Condition".  Exception: for switch type of sensors (i.e. dry contact, 

security sensor, AC voltage detector, smoke detector, water detector, and motion 

detector), there is only one option which is "Critical". 

 

The relay action field is a list box located next to the Relay-Activating Threshold 

list box.  There are three options: "Cycle the Relay", "Turn On the Relay", and 

"Turn Off the Relay".  The words "Turn On the Relay" and "Turn Off the Relay" 

can be customized by configuring "Description of Status When Relay On" and 

"Description of Status When Relay Off" options of the Sensor Controlled Relay 

selected to be controlled. 

 

Cycle Time : This is the number of seconds that the relay is driven when "Cycle 

the Relay" is selected as the relay action.  Enter a number from 1 to 255 and 

press the Save button to implement the change. 

 

Trap/Email Filter 

 

Send Trap/Email when Status "Normal" : If not needed this feature can be 

disabled by choosing "No" in the list box, most people may not want messages to 

signify normal conditions. Certain applications and special projects may warrant 

messages being generated when the sensor returns to a normal condition. 
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Continuous time sensor is normal to report : This is for the elimination of 

unnecessary messages during minor fluctuations from the error state into the 

normal state. Enter the time in seconds and press the Save button. The amount 

of time that can be entered is between 0 and 65535 seconds which equals 

approximately 18 hours. 

 

Continuous time sensor is warning/error to report  : There is also a Delay 

before sending Trap/Email on error, and it is set in the same manner as above. In 

this case the sensor is in the normal state and will ignore momentary fluctuations 

into the error state. 

 

Example, an airflow sensor or water detector may have temporary drops in 

readings which are normal operating characteristics, a logical time limit is set to 

show abnormal conditions. 

 

Minimum time between each Trap/Email : This is the time in minutes between 

each Trap/Email. This is to prevent sending of multiple Traps/Emails, for the 

same event over a period of time. 

 

Day of week Filter: With this option you can either enable or disable the 

operation of sensors on the sensorProbe corresponding to the time period set in 

this filter. The settings can be made for every day and hour of the week. The time 

interval range can be from 00:00 hrs to 24:00 hrs.  The sensors will not change 

the status during the time interval set. 

Example: A nursery may monitor the temperature of a tropical growing room, but 

on Sundays it is open to the public, temperature fluctuations are ignored by the 

sensorProbe as the interval has been set during open hours. 
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A/D Converter Calibration 

Analog sensors such as DC voltage sensor and 4-20mA sensor have its value 

digitized using microcontroller’s A/D converter.  The voltage reference of the 

converter can be calibrated, and it is pre-calibrated from factory.  However, the 

DC voltage sensor and 4-20mA sensor may contain an error due to errors in 

circuit components (i.e. resistors and capacitors).  This error is less than 1% full 

scale.  When you use a DC sensor or 4-20mA sensor on the pre-calibrated 

sensorProbe, the error from the sensor reflects on the reading when displayed on 

the web interface. 

 

Different sensors will have different error level.  Thus, if you have more than one 

DC voltage sensors or 4-20mA sensors, or have both types of sensors on the 

same sensorProbe, it is very possible that one sensor has less amount of 

reading error than the other sensors.  We have added a method so that you can 

adjust the offset to each sensor port individually.  You can do this by using 

snmpset command to a specific OID. 

 

snmpset <ip> <community_string> 
.1.3.6.1.4.1.3854.1.2.2.1.96.<index> i <value> 

 

where 

  <ip> - the IP address of the sensorProbe 

  <community_string> - the administrator password.  The default value is 

“public”. 

  <index> - a value of one less than a port number.  Thus, if you are to 

calibrate for the sensor on port #3, <index> should be replaced with a 

number 2. 

  <value> - an offset value that you will use to adjust the reading of sensors. 

 The number for this value is between 375 and 625. 
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For example, if you have a DC voltage sensor connected to a sensor port #5 of 

the sensorProbe8 which has an IP address of 192.168.0.100 and a default 

password, the snmpset command to set the offset value to 485 will look like the 

following. 

 

snmpset 192.168.0.100 public .1.3.6.1.4.1.3854.1.2.2.1.96.4 i 

485 
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Temperature Sensor 

Temperature sensors are important where optimum temperature control is 

paramount. If there is an air conditioning malfunction or abnormal weather 

conditions, damage to information, delicate electronic equipment or warehouse 

stock may occur. 

 

Up to 2 temperature sensors can be plugged into RJ45 jacks on the 

sensorProbe2 and up to 8 temperature sensors on the sensorProbe8. Optional 

temperature sensors can be purchased with 15, 60, or 100 feet of cable, allowing 

the sensors to be positioned in hot spots. The sensorProbe auto detects the 

presence of the sensor. Each sensor has its own SNMP OID so that data can be 

collected over the network and graphed. 

 

A commonly used SNMP OID for the temperature sensor is the number of 

degrees. This information can be used for graphing the sensor. 

 

The SNMP OID for the temperature sensor degrees on RJ45#1: 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.0 

 

Specifications & Features: 

 Never needs Calibration  

 Measurement range Celsius:-55°C to +75°C  

 Measurement resolution Celsius: 1°C increments.  

 Measurement accuracy Celsius: ±0.5°C accuracy from -10°C to +75°C  

 Measurement range Fahrenheit: -67°F to +167°F  

 Measurement resolution Fahrenheit: 1°F increments.  

 Measurement accuracy Fahrenheit: ±0.9°F accuracy from +14°F to 

+167°F  

 Communications cable: RJ45 jack to temperature sensor using UTP Cat 5 

cable. 
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 Sensor type: semiconductor microprocessor controlled  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the temperature sensor  

 Measurement rate: one reading every second  

 Up to 2 temperature sensors per sensorProbe2 and 8 per sensorProbe8  

 Full Autosense including disconnect alarm 

 The sensorProbe Temperature Detail page allows you to set and get the 

working parameters of a specific temperature sensor in the sensorProbe.  

 

Configuring the Temperature Sensor. 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the temperature sensor. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

Current Reading : The number of Degrees is displayed in this read-only field. 

 This is an integer SNMP OID field which has a precision of 1 degree. The value 

can be polled via SNMP, and the data can be used to graph the temperature 

variations. The value displayed can be in Fahrenheit or Celsius. If communication 

to the temperature sensor is lost, the sensor value -512 will be returned by a 

snmpget. 

 

Hint: The actual precision for the temperature sensor is 0.9°F (0.5°C). 

 Nevertheless, the Current Reading field only displays the temperature with an 

increment/decrement of 1 degree.  To retrieve the actual reading from the 

temperature sensor, another SNMP OID must be used; it is: 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.14.0 for the sensor on RJ45#1. 
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However, since this is an integer SNMP OID, the temperature must be multiplied 

by 10 before polled via SNMP.  Therefore, the returned value has to be divided 

by 10 to become the actual temperature. 

 

Status : If at any time communications with the temperature sensor are lost, the 

status of the temperature sensor is changed to sensorError. If communications 

with the temperature sensor are re-established the status will be formed by 

comparing the Degree to the high and low thresholds.  

 

Degree Type : The Degree Type can be set to Fahrenheit or Celsius. When the 

Degree Type is changed all the threshold fields will change their values 

automatically. The sensorProbe stores the thresholds for both Celsius and 

Fahrenheit independently allowing you to switch between the two. 
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Single Port Temperature/Humidity Sensor 

A new sensor from the AKCP family of sensors, the dual sensor has both 

temperature and humidity measuring capabilities in a single sensor. Now a single 

port can have two sensors, saving ports for additional sensors. This extends the 

capability of the sensorProbe to measure up to 2 temperature and 2 humidity 

sensing parameters, just by connecting 2 dual sensors for the sensorProbe2, or 

8 temperature and 8 humidity sensing parameters for the sensorProbe8. 

 

Up to 2 dual sensors on the sensorProbe2 ,or 8 dual sensors on the 

sensorProbe8.  Specially designed CAT5 cable assures a correct reading up to 

100 feet, and is available in standard length of 1 foot, 15 feet, 60 feet and 100 

feet, allowing the sensors to be positioned in hot spots. 

 

When the dual sensor is plugged into the RJ-45 port, the sensorProbe will auto 

detect the sensor, and it will display Temperature & Humidity for each RJ-45 port. 

 A built in graph option is available on the sensorProbe for graphing temperature 

and humidity variations over a period of time. 

 

The SNMP OID for the temperature sensor on RJ45#1 is 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.0 

The SNMP OID for the humidity sensor on RJ45#1 is 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.0 

 

Specifications & Features: 

Temperature 

• Measurement range Celsius:-40°C to +75°C  

• Measurement resolution Celsius: 1°C  

• Measurement accuracy Celsius: ±0.2°C accuracy from -10°C to +75°C  

• Measurement range Fahrenheit: -67°F to +167°F  

• Measurement resolution Fahrenheit: 1°F increments.  
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• Measurement accuracy Fahrenheit: ±0.4°F accuracy from +14°F to 

+167°F  

 

Humidity  

• Measurement range: 0 to 100% Relative humidity  

• Sensor element wettable without damage  

• Resolution: 0.5 % 

• Accuracy at 25°C ±3%, 

• Working Range -20°C +60°C  

 

 Communications cable: RJ-45 jack to dual sensor using UTP Cat 5 cable. 

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the dual sensor 

 Up to 8 dual sensors per sensorProbe  

 Full Autosense including disconnect alarm 

 

 

Configuring the Dual sensor 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the humidity sensor. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

Temperature 

A commonly used SNMP OID for the temperature sensor is the number of 

degrees. This information can be used for graphing the sensor. 

The SNMP OID for the temperature sensor on RJ45#1 is 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.0 
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Current Reading : The number of Degrees is displayed in this read-only field. 

 This is an integer SNMP OID field which has a precision of 1 degree. The value 

can be polled via SNMP, and the data can be used to graph the temperature 

variations. The value displayed can be in Fahrenheit or Celsius. If communication 

to the temperature sensor is lost, the sensor value -512 will be returned by an 

snmpget. 

 

Hint : The actual precision for the temperature sensor is 0.4°F (0.2°C). 

 Nevertheless, the Current Reading field only displays the temperature with an 

increment/decrement of 1 degree.  To retrieve the actual reading from the 

temperature sensor, another SNMP OID must be used; it is: 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.14.0 for the sensor on RJ45#1. 

However, since this is an integer SNMP OID, the temperature must be multiplied 

by 10 before polled via SNMP.  Therefore, the returned value has to be divided 

by 10 to become the actual temperature. 

 

Status : If at any time communications with the temperature sensor are lost, the 

status of the temperature sensor is changed to sensorError. If communications 

with the temperature sensor are reestablished the status will be formed by 

comparing the Degree to the high and low thresholds.  

 

Degree Type : The Degree Type can be set to Fahrenheit or Celsius. When the 

Degree Type is changed all the threshold fields will change their values 

automatically. The sensorProbe stores the thresholds for both Celsius and 

Fahrenheit independently allowing you to switch between the two. 

 

 

Humidity 

A commonly used OID for the Humidity sensor is the percentage, this can be 

graphed.  
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SNMP OID for Humidity sensor on RJ45#1  

OID .1.3.6.1.4.1.3854.1.2.2.1.17.1.3.0 

 

Percent : The relative Humidity Percent is displayed in this field. This is a read-

only field. This integer OID and can be polled. The data can be used to graph the 

Humidity.  

   

Status : If at any time communications with the humidity sensor are lost, the 

status of the Humidity sensor is changed to sensorError. When communications 

with the humidity sensor are re-established the status will be formed by 

comparing the percentage to the high and low thresholds. 
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Water Detector 

Water can enter a building in many different ways and, in some cases, remain 

undetected.  This causes damage and problems to sensitive electronic 

equipments.  Computer and main frame rooms have a false floor, and many 

instances of undetected water, laying in these areas, has only been detected 

after a problem occurred. The water detector is an important addition to your 

AKCP sensor inventory. 

 

The water detector is an exclusive patent pending design, capable of detecting 

the presence of even distilled water. The water detector contains a 

microprocessor controlled capacitance measuring circuitry. This is far more 

precise than commercially available standard water detectors which measure the 

resistance of water. Since the resistance of water can vary depending upon the 

impurities in the water, normal resistance type monitors are unable to detect the 

presence of distilled water due to its high resistance.  

 

The entire circuit is encased in epoxy, allowing the water detector to function 

while submerged in water.  

 

The water detector detects water leaks and flooding with a WET/DRY indication 

in software. The sensorProbe will retain any error condition until it is read via a 

snmpget. Therefore, if a water detector encounters a critical condition at any 

time, it will report that condition before it returns to a normal state.  

 

The value of the status for the SNMP OID for the water detector can be Normal, 

No Status, Critical or sensorError. 

 

For a switch type sensor on RJ45#1 the OID for the status is. 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.0 
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Features:  

 On/Off alarm signal of Water detected   

 Accurate, cost effective Water detecting system 

 Electronics are encased in epoxy and submersible 

 Electronic circuitry capable of detecting distilled water 

 Sensor type - open/closed contact switch  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the Water Detector 

 Up to 2 Water Detectors per sensorProbe2 and 8 per sensorProbe8  

 Includes disconnect alarm that checks that the sensor is securely plugged 

into the sensorProbe 

 

Configuring the Water Detector 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the water detector. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

Status : If the sensor is offline, the status is No Status. If the sensor is online, 

and there is no water detected, the status is Normal. If water is detected, then the 

status is Critical. If at any time communications with the Water Detector are lost, 

the status of the Water Detector is changed to sensorError. 

 

 

 



Intelligent Sensors 

29 

Airflow Sensor 

 

The Airflow Sensor is a device that registers Airflow in areas where consistent 

flow is needed. For example in cabinets and racks where the consistent 

operation of a fan is critical to the operational safety of electronic equipment. 

 
The Airflow sensor is placed in the air stream, where the user can monitor the 

status and the amount of flowing air. In addition to an on/off indication, it also 

graphs the analog values over a period of time, although not a precision airspeed 

measurement device, If for example, the fan slows down the user will be given an 

indication of the change over time. This may happen if the fan is close to failure 

or the air filter is clogged. The sensorProbe shows this information using a graph 

via the web interface.  

 

The value of the Status for the OID for switch sensors can be Normal, No Status, 

Critical, or sensorError. 

 

The recognized OID for switch Sensors is 1 or 0, for RJ45#1 it is 

OID .1.3.6.1.4.1.3854.1.2.2.1.17.1.3.0 

 

Features:  

 On/Off alarm signal of airflow  

 Airflow data graphically displayed over time  

 Accurate, cost effective flow sensing  

 2 LEDs indicate the status of Airflow and that the sensor is securely 

plugged into the sensorProbe 

 Electronics are mounted in a small plastic case  

 Sensor type - open / closed contact switch  

 Power source: powered by the sensorProbe. No additional power needed.  
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 The sensorProbe auto detects the presence of the airflow sensor  

 Up to 2 Airflow Sensors per sensorProbe2 and 8 per sensorProbe8.  

 Includes disconnect alarm that checks that the sensor is securely plugged 

into the sensorProbe 

 

Specifications:  

 Data graphically displayed via a web page  

 Data collection possible via any SNMP based network management 

system 

 Measurement rate: one reading each second, data logging once per 

minute  

 Communication cable: RJ-45 jack to the sensorProbe  

 Sensor type: Thermistor  

 Sensor power: line power from the sensorProbe  

 Trap information: Status, sensor number, Sensor description, Airflow (%)   

  

Configuring the airflow sensor 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the Airflow sensor. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

Current Reading : The percentage of airflow is displayed in this field. This is a 

read-only field. This is an integer SNMP OID field. This value can be polled via 

SNMP and the data can be used to graph the air-flow. The values range is from 0 

to 100 %. 
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Status : If the sensor is offline, the status is No Status. If the sensor is online, the 

status will be formed by comparing the readings to the high and low thresholds. 

 If at any time communications with the Airflow Sensor are lost, the status of the 

Airflow Sensor is changed to sensorError. 
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AC Voltage Detector 

The voltage detector is used to indicate the presence or absence of line voltage. 

This is useful, for example to tell when the UPS is running on battery power. 

 

The AC Voltage Detector indicates an ALARM/NORMAL condition in software 

and also via an LED mounted on the sensor. Voltage detectors can detect the 

presence or the absence of line voltage. It is designed for use worldwide. There 

is an SNMP interface for getting the alarm/normal status. SNMP traps are sent 

when critical conditions occur. SNMP polling via get is available to retrieve 

existing status and configuration parameters. The Web browser interface is also 

available to display the status and configuration parameters.  

 

When an alarm condition is activated the description and location of the fault can 

be sent via email, page or traps. 

 

The value of the Status for the OID for switch sensors can be Normal, No Status, 

Critical, or sensorError. 

 

The recognized OID for switch Sensors is 1 or 0, for RJ45#1 it is 

OID .1.3.6.1.4.1.3854.1.2.2.1.18.1.3.0 

 

Specifications & Features: 

 Measurement range - Detects voltage at 50V AC to 250V AC 

 LED indicator on sensor shows if voltage present  

 Measurement Indication - Alarm or Normal  

 Communications cable - RJ-45 jack to sensor using UTP Cat 5 wire.  

 Sensor type - open / closed contact switch  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the voltage sensor  

 Measurement rate - multiple readings every second  
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 Up to 2 sensors per sensorProbe2 and 8 per sensorProbe8.  

 Full Autosense including disconnect alarm  

 

Configuring the AC voltage Detector 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the AC voltage sensor. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

Status :  If the sensor is offline, the status is No Status. If the sensor is online 

and there is no AC voltage detected, the status is Critical. If AC voltage is 

detected, then the status is Normal.  If at any time communications with the AC 

voltage detector are lost, the status of the AC voltage detector is changed to 

sensorError 
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Security Sensor 

The Security sensor is a magnetic on/off switch which is used as an input to the 

sensorProbe. Security Sensors come in pairs. They are active switches that 

close when one half of the sensor is in close proximity to its mate. When the two 

sensor pairs are moved apart from each other, they open. The sensorProbe 

senses closure and opening and reports the condition. 

 

Security Sensors can be wired in series so that multiple sensors can use a single 

port on the sensorProbe. There are no reasonable limits on the distance of the 

security sensors from the sensorProbe.  The Security sensor features an 

ALARM/NORMAL indication in the software. Security sensors can be used to 

detect open doors, cabinets, or windows. 

 

The sensorProbe will retain any error condition until it is read via a snmpget. 

Therefore if a security sensor encounters a critical condition at any time it must 

report that condition before it can return to a normal state. 

 

A popular OID for switch Sensors is the status. For RJ45#1 it is 

OID .1.3.6.1.4.1.3854.1.2.2.1.18.1.3.0 
 
Features:  

 On/Off alarm signal when Security Sensors switches open/closed 

 Accurate, cost effective Security System 

 Electronics are simple and reliable  

 Sensor type - open/closed contact switch  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the Security sensor  

 Up to 2 Security Sensors per sensorProbe2 and 8 per sennsorProbe8 (or 

many more if wired in series) 
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 Includes disconnect alarm that checks that the Security sensor is securely 

plugged into the sensorProbe 

 

Configuring the Security sensor 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the Security sensor. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

Status : If the sensor is offline, the status is No Status. If the sensor is online and 

there are no open sensors detected, the status is Normal. If an open Sensor is 

detected, then the status is Critical. If at any time communications with the 

Sensor are lost, the status of the Security Sensor is changed to sensorError. 
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Dry Contact Sensor 

 

The Dry Contact sensor is a simple connection to burglar alarms, fire alarms or 

any application that requires monitoring by the sensorProbe.  Dry contact 

sensors are user definable and can be used to detect many different inputs such 

as UPS status, security systems, air conditioning status.  

 

These general purpose switches can be either input or output. When used as an 

output it can source up to 20 mAmps. You can select the output voltage by 

setting the Output Level to a Low or a High. When set to Low, the pin will output 

0 volts. When set as a High, the pin will output 5 volts.  

 

When used as an input a switch will retain any error condition until it is read via 

SNMP. Therefore, if a switch encounters a critical condition at any time, it must 

report that condition before it can return to a normal state.  

 

Input pins can be used to detect whether or not an input switch is open or closed. 

In combination with external sensors, input pins can detect whether a door or 

window is open or closed, if there is a water incursion and many other conditions.  

 

The input pins work by sensing the presence of a voltage level on an input pin, 

when the switch is open the voltage is different than when the switch is closed.   

 

To test a dry contact input, wire ground to one side of the switch. Ground is 

always pin 8 on the connector. Wire the other side of the switch to the switch 

sensor. Set the Normal State field to Open. Set the Direction field to Input. When 

the switch closes, the input pin will be shorted to ground and the switch will 

change state from normal to critical  
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Specifications & Features: 

 Measurement Indication - Alarm or Normal  

 Communications cable - RJ45 jack to sensor using UTP Cat 5 wire.  

 Sensor type - open/closed contact switch  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the voltage sensor  

 Measurement rate - multiple readings every second  

 Up to 2 sensors on the sensorProbe2 and 8 per sensorProbe8  

 Full Autosense including disconnect alarm  

 

Configuring the Dry Contact Sensor 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the Dry contact sensor. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

Direction : The Switch Direction can be either Input or Output. When set as an 

Input, the sensor will report its status as either Normal, Critical High, or Critical 

Low. The status is Normal if the Normal State field matches the current value 

applied to the sensor. For example, if the Normal State field is High and the input 

to the sensor is high then the status is Normal. The input voltage should be 

limited to 0 to 5 volts in order to protect the sensor.  

 

If the Direction of the sensor is Output, the sensor can be used to drive external 

equipment. 

 

Output Level : The Switch Output Level field can be either High/+5 Volts or 

Low/GND. When set to a High, the output value of 5 volts will be applied to the 
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switch. When set to a Low, the Output Level field will depend upon the value of 

Direction. If Direction is set to Output and the Output Level field is set to low, the 

Switch will source current in order to maintain 0 Volts. If Direction is set to Input 

and the Output Level field is set to low, the Switch will become tri-state.  

 

The Output levels of High will pull-up the switch even if the Direction is set to 

Input. However, when the Switch Direction is set to Input and Output level is set 

to high the Switch will output a weak pull-up current. This output can be 

overridden by shorting the pin to ground. In this way, an external switch can be 

determined to be open or closed.  

 

Normal State : The Switch Normal State field can be either Open/+5 Volts or 

Closed/GND. When set to a +5 Volts, the input value of 5 volts will cause the 

Status to be reported as normal. When set to +5 Volts, the input value of 0 volts 

will cause the Status to be reported as Critical Low. When the Switch Normal 

State is set to a Low, the input value of 5 volts will cause the Status to be 

reported as Critical High, and the input value of 0 volts will cause the Status to be 

reported as normal.  

 

Information on Dry contact cables 

The extension length of the dry contact twisted pairs is limited only by the amount 

of electromagnetic noise in the area. So the lengths can be quite long, but long 

cable lengths may create occasional false positives. These false positives can be 

eliminated with the advanced filtering of the sensorProbe. You can define how 

long a sensor must be in the error condition before changing state from Normal 

to Critical. You can also define how long the sensor must remain in the Normal 

state before changing from Critical to Normal. 

 

If the dry contact cable is run outdoors where lighting strikes may occur or if the 

cable length is very long we recommend the use of the sensorProbe8-X20 or the 

sensorProbe8-X60 which includes integrated opto-isolators. This will protect the 
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sensorProbe8-X20/X60 in case of a lightning strike. This is because there is no 

connection to the power supply in the sensorProbe8-X20/X60. This is done in 

order to provide complete isolation and protection to the sensorProbe8-X20/X60. 

   

 

Special Dry Contact settings for the X20 and X60 models of the 

sensorProbe8 ports 9-68. 

 

 By default, X20 and X60 will have the jumpers set as in Fig 1 for ports 9-68  

 

                             Fig 1                                                      Fig 2  

 

 

The simplest setup for Dry Contact inputs is as shipped. In this setup, power is 

provided by the sensorProbe8 to the switches. With the sensorProbe8 providing 

the power, the switch has +5 Volts applied to pin 1 and GND applied to pin 2. 

When the switch is open, the input senses +5, when the switch closes, the input 

senses GND. No additional external power is needed. 
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Figure 2 shows the jumpers set up to provide opto-isolators support. Opto-

isolators provide complete electrical separation between the sensorProbe8 and 

the dry contact. The sensorProbe8 is therefore protected against possible large 

voltage spikes caused by lightning for example. 

 

The user can change the settings by opening the top cover of the sensorProbe8-

X20/X60 and changing the jumper settings according to the Fig 2. This will set up 

the X20/X60 for opto-isolators inputs. 

 

Note: Dry contact ports - ports 9-68 on the X20 and X60 models of the 

sensorProbe8 do not have the Autosense feature. The user has to manually 

place these ports online.  
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Configuring up to 10 dry contact inputs on the 
sensorProbe2 

 

An optional feature of the sensorProbe2 is the ability to have up to 5 dry contact 

inputs per RJ45 sensor port.  This gives total maximum possible inputs of 10 per 

sensorProbe2 by utilizing both of the RJ45 sensor ports 

 

These dry-contact ports can be used to monitor any dry-contact inputs, just like 

the normal autosense dry-contact ports, but these ports can only be set to 

operate in the input mode. 

 

These additional sensors are labeled as ports 3 to 12. 

 

When you buy a sensorProbe2 with this feature, it is already enabled.  To turn on 

this feature: 

1) Click the "Sensors" tab, then on the left menu click "Dry Contacts (3-12)" 

2) Press the button of the sensor that you want to use and place it online. The 

additional sensors located on RJ45 number 1 are sensors 3-7, for RJ45 number 

2; they are sensors 8-12. 

 

If you buy a sensorProbe2 without this feature enabled, you can contact our sale 

department to purchase a password code to unlock ability to use up to 10 dry 

contact inputs. 

 

Suppose you have purchased the code, follow the steps below to enable the 

feature. 

1) Click the "Sensors" tab, then on the left menu click "Dry Contacts (3-12)" 

2) Enter a code that in "Enable Extra Dry Contact Password" field.  And, click 

"Save".  To prevent mistyping the code, use cut or copy and paste the code to 
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the password field.  If you decide to type it in, please use an uppercase for all 

characters. 

3) Then, a list of dry contact switches is displayed. 

4)  Press the button of the sensor that you want to use and place it online. The 

additional sensors located on RJ45 number 1 are sensors 3-7, for RJ45 number 

2; they are sensors 8-12. 

 

Note: At step 3, if there is a problem, it will display "Extra Dry Contacts are 

disabled".  If you are certain that everything is correct, please contact 

support@akcpinc.com for assistance. 

 

Below is the color coding and the picture of the wires: 

 

Colour Pin 
Black GND/Common 
Blue 1 

Yellow 2 
Brown 3 
Orange 4 

Red 5 
 

 

Image: RJ-45 cable with 5 Dry-contact wires 
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DC Voltage Sensor 

Any company or building with a large battery bank or solar power storage or 
involvement in the manufacture or storage of batteries needs this sensor. 
 
The DC voltage sensor is a custom sensor that works very much like a digital 

voltmeter. The DC voltage sensor can measure voltages in the range of 0 to 60 

or -60 to 0volts.  

 

One popular OID for the DC Voltage Sensors is the current reading. 

For a DC Voltage sensor plugged into RJ45#1 that OID is: 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.0 

 

Specifications & Features: 

 Measurement range - 0 to 60V or -60 to 0V 

 Overvoltage protection. A relay within the DC Voltage sensor will protect 

the sensorProbe. 

 Status range - HighWarning, Low Warning, High Critical, Low Critical  

 Communications cable - RJ-45 jack to sensor using UTP Cat 5 wire, 

Maximum extension cable length 100 foot with approved low capacitance 

shielded cable or UTP.  

 Resolution - 10 bit A/D converter  

 Accuracy - ±1%  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the DC voltage sensor  

 Measurement rate - multiple readings every second  

 Up to 2 DC voltage sensors per sensorProbe2, or 8 sensors per 

sensorProbe8  

 Full Autosense including disconnect alarm  
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Configuring the DC voltage sensor 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the DC voltage sensor. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

The A/D converter of the sensorProbe may need to be calibrated when using 

with a DC voltage sensor if the reading from the sensor is off from the expected 

value.  To calibrate the A/D converter of the sensorProbe, please see the A/D 

Converter Calibration page. 

 

DC Voltage Sensor Settings Section 

Current Reading : The percentage or absolute value of DC voltage is displayed 

in this field. This is a read-only field.  This value can be polled via SNMP, and the 

data can be used to graph the value of DC voltage. The value range is set by the 

base and max scale fields in the Custom DC Voltage Sensor Settings Section. 

 

Status : The current reading is compared to the thresholds of Critical High, 

Warning High, Critical Low, and Warning Low that the user has set. From this, 

the status is then formed, and emails, traps are sent if necessary. 

 

Critical High, Warning High, Warning Low, and Critical Low : These 

thresholds should be re-entered every time there is a change in the type of scale 

(whether an absolute value or a percentage value is used) 

 

Custom DC Voltage Sensor Settings Section 

Display Units :  This field should be entered with an appropriate unit of the 

measured entity when the DC voltage sensor is used with the custom sensor. 
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 For example, this filed might be entered with Pounds or Lbs when the DC 

voltage sensor is used with the custom pressure sensor or Volts for an absolute 

value of measured DC voltage. 

 

Type of scale : This field is used to select whether to display the current reading 

as an absolute value or a percentage. 

 

Selected Scale (Jumper 0) : This field should be set accordingly to the same 

value that is physically set by the jumper on the DC Voltage sensor.  This field 

can be set to 60, 40, 30, 20, 10, -10, -20, -30, -40 or -60. You should select the 

jumper value nearest to the maximum value inserted to the DC Voltage sensor in 

order to achieve the maximum resolution. 

 

Max scale of sensor in volts : This field should be entered with the maximum 

value of the voltage that is input to the DC Voltage sensor.  For example, if the 

DC Voltage sensor is used to measure the voltage in a range of 0 to 50 volts, this 

filed should be filled in with 50.  Or, if the DC Voltage sensor is used to integrate 

with the custom sensor, this filed should be set to the maximum output voltage 

from the custom sensor.  Note that the voltage range inside the bracket located 

behind the field name is changed accordingly to the value selected in the 

"Selected Scale (Jumper 0)" field. 

 

Base scale of sensor in volts : This field should be entered with the minimum 

value of the voltage that is input to the DC Voltage sensor.  For example, if the 

DC Voltage sensor is used to measure the voltage in a range of 0 to 50 volts, this 

filed should be filled in with 0.  Or, if the DC Voltage sensor is used to integrate 

with the custom sensor, this filed should be set to the minimum output voltage 

from the custom sensor.  Note that the voltage range inside the bracket located 

behind the field name is changed accordingly to the value selected in the 

"Selected Scale (Jumper 0)" field. 
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How Many Percent or How Many Unit (Max Scale) : The field name is changed 

accordingly to the selected type of scale (absolute value or percentage).  When 

the type of scale is set to Absolute, this field should be set to the maximum 

absolute value that can be measured by the DC Voltage or the custom sensor. 

 In the DC Voltage sensor case, the value in this field should be the same as that 

in the "Max scale of sensor in volts" field. 

 

How Many Percent or How Many Unit (Base Scale) : The field name is 

changed accordingly to the selected type of scale (absolute value or percentage). 

 When the type of scale is set to Absolute, this field should be set to the minimum 

absolute value that can be measured by the DC Voltage or the custom sensor. 

 In the DC Voltage sensor case, the value in this field should be the same as that 

in the "Base scale of sensor in volts" field. 

 

Example:  assuming the DC Voltage sensor is integrated with a custom water 

level sensor which output 0-25 volts for water level in range of 5-150 centimetre 

(cm).  Enter "Display Unit" as "cm" for centimetre.  Select "Type of Scale" as 

"Absolute".  Others should be configured as follow: 

 

Setting Fields Value 
Selected Scale (Jumper 0) 30 

Max Scale of Sensor in Volts 25.0 

Base Scale of Sensor in Volts 0.0 

How Many cm at 25.0 Volts 150.0 

How Many cm at 0.0 Volts 5.0 

 

 

Polarity Switch and Jumper 

The DC Voltage sensor has a polarity switch to select whether it is used to 

measure the DC voltage in positive (+) or negative (-) value.  Moreover, there is a 

jumper to set the expected range of input voltages. This can be set to 10, 20, 30, 
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40 or 60V.  Both a polarity switch and a jumper are used together to determine 

the range of the measurement. 
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4-20mA Converter 

 

The 4-20 mAmp signal converter is used to integrate the sensorProbe with a 4-

20 mAmp transmitter. 4-20 mAmp technology is used to communicate analog 

signals over long distances where electrical interference is a problem. This 

solution is often used in the process control industry to collect the analog values 

from a wide array of remote sensors. Current signals are much less susceptible 

to noise than voltage signals. A voltage signal can be converted to current and 

then broadcast over a long distance before it is converted back to voltage and 

read by the sensorProbe. 

 

4-20 mAmp transmitters are common in the industry for use with high quality 

sensors. With the 4-20 mAmp converters, these sensors can now be integrated 

into the sensorProbe, enhancing their value with the addition of graphing, web 

interface, email interface, thresholds, and limits.  

 

One popular OID for the 4-20 mAmp Converters is the percentage of full scale 

reading. 

 

For a 4-20 mAmp Converter plugged into RJ45#1 that OID is: 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.0 

 

Specifications & Features: 

 Electronics housed in small plastic case 

 LED indicators on Converter show connection to the sensorProbe  

 Communications cable - RJ45 jack to sensor using UTP Cat 5 wire.  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the 4-20mA Converter  
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  Up to 2  4-20mAmp Converters on the sensorProbe2 and 8 per 

sensorProbe8  

 Full autosense including disconnect alarm 

 

Configuring the 4-20mAmp Converter 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the 4-20mAmp converter. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

The A/D converter of the sensorProbe may need to be calibrated when using 

with a 4-20mAmp converter if the reading from the sensor is off from the 

expected value.  To calibrate the A/D converter of the sensorProbe, please see 

the A/D Converter Calibration page. 

 

4-20mAmp Sensor Settings Section 

 

Current Reading : The percentage or absolute value of 4-20mAmp converter is 

displayed in this field. This is a read-only field.  This value can be polled via 

SNMP, and the data can be used for graphing. The value range is set by the 

base and max scale fields in the Custom 4-20mAmp Sensor Settings Section. 

 

Status : The current reading is compared to the thresholds of Critical High, 

Warning High, Critical Low, and Warning Low that the user has set. From this, 

the status is then formed, and emails, traps are sent if necessary. 
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Critical High, Warning High, Warning Low, and Critical Low : These 

thresholds should be re-entered every time there is a change in the type of scale 

(whether an absolute value or a percentage value is used) 

 

Custom 4-20mAmp Sensor Settings Section 

 

Display Units :  This field should be entered with an appropriate unit of the 

measured entity.  For example, this filed might be entered with Pounds or Lbs 

when the input of the 4-20mAmp sensor is a measured pressure, or mAmp for an 

absolute value of measured current. 

 

Type of scale : This field is used to select whether to display the current reading 

as an absolute or a percentage value. 

 

Max Scale of Sensor in mAmp : This field should be entered with the maximum 

value of the milliampere that is input to the 4-20mAmp sensor.  For most cases, 

the value of this field should be 20. 

 

Base Scale of Sensor in mAmp : This field should be entered with the minimum 

value of the milliampere that is input to the 4-20mAmp sensor.  For most cases, 

the value of this field should be 4.   

 

How Many Percent or How Many Unit (Max Scale) : The field name is 

changed accordingly to the selected type of scale (absolute value or percentage). 

 When the type of scale is set to Absolute, this field should be set to the 

maximum absolute value of a measured entity which is input to the 4-20mAmp 

sensor.  When the type of scale is set to Percent, this filed should be set to 100 

percent. 

 

How Many Percent or How Many Unit (Base Scale) : The field name is 

changed accordingly to the selected type of scale (absolute value or percentage). 
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 When the type of scale is set to Absolute, this field should be set to the minimum 

absolute value of a measured entity which is input to the 4-20mAmp sensor. 

 When the type of scale is set to Percent, this filed should be set to 0 percent. 

Example:  assuming the 4-20 mAmp sensors is input from a pressure sensor 

which output 4-20 mAmp for pressure in range of 50-300 pounds.  Enter "Display 

Unit" as "Lbs" for pound.  Select "Type of Scale" as "Absolute".  Others should be 

configured as follow: 

 

Setting Fields Value 
Max Scale of Sensor in mAmp 20.0 

Base Scale of Sensor in mAmp 4.0 

How Many Lbs at 20.0 mAmp 300.0 

How Many Lbs at 4.0 mAmp 50.0 

 

Below is an illustration of a typical 4-20mAmp setting: 

 

 

  

Input Amp Percent(%) 

4.06 mA 1 

9.9 mA 36 
15.1 mA 69 
19.8 mA 99 
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Relay Operation 

In this manual, when saying "turn on" the relay means the contacts in the relay are 

closed to transmit electricity from the inlet side to the outlet side of the Sensor Controlled 

Relay.  Similarly, saying "turn off" the relay means the contacts in the relay are open; 

hence, electricity does not get transmitted. 

 

Automatic Response Feature 

Relay operation can be actuated manually by users via the web interface, or 

automatically by automatic response feature.  For automatic response to the 

alarm condition -- the status of sensor(s), you can link the Sensor Controlled 

Relay with any of the sensors connected to the sensorProbe.  When using 

sensors to actuate the relay, you must configure parameters so that the relay 

functions as desired. 

 

Since the sensorProbe is designed so that more than one sensors can control 

the same relay board, there exist rules for controlling the relay in such cases. 

 Those rules will be explained later in this manual. 

 

Manual Relay Control 

Manual Relay Control is a basic operation of the relay board.  That means the 

relay is not tied to any sensors on the sensorProbe.  Its operation depends only 

on users to select what action they want the relay to perform. 

 

When you select to control the relay manually, the relay action command can be 

either "Cycle Turn On-Turn Off-Turn On", "Cycle Turn Off-Turn On-Turn Off", 

"Turn On", or "Turn Off". 
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Note: the words "Turn On" and "Turn Off" can be customized by configuring 

"Description of Status When Relay On" and "Description of Status When Relay 

Off" fields in the relay setting page of the web interface. 

 

Each relay action command can be described as follow. 

 

Cycle Turn On-Turn off-Turn On : When this action is selected, the relay is 

turned off for a certain number of seconds called "Cycle Time".  After this period 

is over, the relay will be turned back on.  The relay operates as described 

regardless of its state when the command is executed.  For example, if the relay 

is currently off and the cycle time is set to 30 seconds, when you command the 

relay to "Cycle Turn On-Turn Off-Turn On", the relay stays off for another 30 

seconds before turning on.  If the relay is currently on, when you select this 

action for the relay, it will be turned off for 30 seconds, and then turned back on. 

 

Cycle Turn Off-Turn On-Turn off : When this action is selected, the relay is 

turned on for "Cycle Time" seconds.  After the period is over, the relay is turned 

to off.  Similarly to the previous one, the relay operates as described regardless 

of its state when the command is executed. 

 

Turn On : Once this option is selected, the relay is turned to on.  It will stay on 

unless other action is selected. 

 

Turn Off : Once this option is selected, the relay is turned to off.  It will stay off 

unless other action is selected. 

 

Note:  All of relay action commands when executed can override the previous 

command that the relay is performing.  For example, assume that the relay is 

now performing "Cycle Turn Off-Turn On-Turn Off" and have not finished its 

cycle.  If the user sets the relay to "Cycle Turn Off-Turn On-Turn Off" again, it 

takes and performs a new command, and it will stay on for another "Cycle Time" 
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seconds because the first cycle command is already overridden by the second 

cycle command.   

 

For another example, we assume that the relay is now performing "Cycle Turn 

On-Turn Off-Turn On" and have not finished its cycle.  If the user commands the 

relay to "Turn On", the relay will switch from off to on even though the "Cycle 

Time" seconds is not over because the cycle action command is overridden by 

the "Turn On" command. 

 

Once the relay action is changed to be controlled by sensors (by selecting "Allow 

Sensor to Control" option), no matter what current state of the relay is at the time, 

it is changed depending on configurations by those sensors. 

 

Sensors Control Relay 

This is an advanced operation of the relay board since users can tie one or more 

sensors to control the same relay.  The relay is actuated whenever the current 

status of a sensor reaches a so-called "Relay Activating Threshold".  For non-

switch type of sensors, it can be one of the following five options: "High Critical", 

"HighWarning or High Critical", "Low Warning or Low Critical", "Low Critical", or 

"Any Error Condition". 

 

High Critical : The relay is actuated only when the sensor status becomes High 

Critical. 

HighWarning or High Critical :  The relay is actuated when the sensor status 

becomes either HighWarning or High Critical. 

Low Warning or Low Critical :  The relay is actuated when the sensor status 

becomes either Low Warning or Low Critical. 

Low Critical : The relay is actuated only when the sensor status becomes Low 

Critical. 

Any Error Condition :  The relay is actuated when the sensor status becomes 

all types of status except Normal and Not Plugged In. 
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For switch type sensors, the Relay Activating Threshold can be only "Critical". 

 The switch type sensors include dry contact, security sensor, AC voltage 

detector, smoke detector, water detector, and motion detector. 

 

Once actuated, the relay action command can be either "Cycle the Relay", "Turn 

On the Relay", or "Turn Off the Relay".  Note: the words "Turn On the Relay" and 

"Turn Off the Relay" can be customized by configuring "Description of Status 

When Relay On" and "Description of Status When Relay Off" fields in the relay 

setting page of the web interface. 

 

Each relay action command can be described as follow. 

 

Cycle the Relay : When this action is selected, the relay state changes to either 

"Turn On" or "Turn Off" depending on what state is set for the  "Sensor Normal 

Relay State" which is also called the normal state.  The relay is driven for "Cycle 

Time" seconds.   After this period is over, the relay is turned back to the normal 

state regardless of the current status of the sensor that actuates it. 

 

For example, if the Sensor Normal Relay State is set to "Turn Off" and the Cycle 

Time is set to 45 seconds, once the relay is actuated, its state becomes "Turn 

On", and stays on for 45 seconds before it changes back to its normal state -- 

"Turn Off". 

 

Turn On the Relay : When this option is selected, the relay is turned to on 

regardless of the normal state.  The relay stays on unless the status of the 

sensor that actuates it differs from the Relay-Activating Threshold. 

 

Turn Off the Relay : When this option is selected, the relay is turned to off 

regardless of the normal state.  The relay stays off unless the status of the 

sensor that actuates it differs from the Relay-Activating Threshold 
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The current action that the relay is performing can be overridden by any action 

commands.  This is similar to what happens in Manual Control Relay except that 

the new action command is not controlled by the user.  Instead, the new 

command is initiated from another sensor configured to control this same relay. 

However, only sensor that has a higher priority than that of the previous sensor, 

which initiated the ongoing action, can take over the relay. 

 

The lower port number the sensor is plugged in to, the higher priority the sensor 

on that port has.  Hence, the sensor plugged in to RJ-45 port #1 has the highest 

priority in controlling the relay.  For a single port Temperature and Humidity 

sensor which has two sensors on the same port, the temperature sensor has 

higher priority than that of the humidity sensor. 

 

The following scenario will help to better understand the relay operation. 

 Assume there are: 

 

 A relay board on sensor port number 8 which its Sensor Normal Relay 

State is set to "Turn Off" 

 A single port temperature and humidity sensor on port number 1 where: 

 The temperature sensor is configured to "Turn On the Relay" when 

its status reaches "High Critical", and 

 The humidity sensor is configured to "Cycle the Relay" for 120 

seconds when its status reaches "HighWarning or High Critical" 

 And, a security switch sensor on port number 2 which is configured to 

"Turn On the Relay" when its status is "Critical".  This sensor is used to 

detect an opened door. 

 

1. The technician enters a room.  So, the security switch goes Critical; the relay 

is now turned on, and should be turned off when the door is closed. 

 However, he forgets to close it.  Thus, the relay still stays on. 
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2. Not long after that, the humidity inside the room starts to rise up, and reaches 

its HighWarning Threshold.  The relay is then cycled to on state for 120 

seconds because the normal state is set to "Turn Off".  Since the relay is 

already turned on from the first event, its state is not changed.  The humidity 

sensor has already taken over the relay operation due to its higher priority 

comparing to the security sensor. 

3. A minute later the same technician realizes he forgot to close the door, and 

comes back to close it.  The relay will not be turned off here since its 

operation is overridden by the humidity sensor.  The relay thus should stay 

on for another one minute, and then it will be turned back to its normal state. 

4. About 30 seconds later, the temperature rises up to the point where the 

status of the temperature sensor is High Critical.  Thus, it takes over the relay 

operation from the humidity sensor. 

5. After 120 seconds starting from the humidity sensor actuated the relay, the 

temperature sensor status is still High Critical.  Then, the relay state is still on 

since its operation have been overridden by the temperature sensor (even it 

is plugged in to the same port as the humidity, but it has higher priority). 

6. The same technician comes to the room, opens the door, and again forgets 

to close it.  This event will not cause the relay to operate because of a lower 

priority the security sensor has. 

7. Once the temperature sensor status changes to HighWarning even though 

the humidity sensor status is also HighWarning, the relay stops its operation 

and changes its state back to the normal state. 
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Sensor Controlled Relay 

The Sensor Controlled Relay allows the user remote actuation of electrical 

devices over Internet. It provides 1 high-power SPDT 5V relay. It includes Metal 

Oxide Varistors (MOVs) and Snubber circuits to protect the open contact of the 

relays from the high voltage spikes or noise transients. It monitors the power load 

and accepts a control signal which is sent from the sensorProbe. 

 

Applications:  

Power Switching  

On/Off Control  

Activate Alarms  

Process Control  

Energy Management Systems  

 

 

Specifications & Features: 

 Relay contacts rated at 15 A @ 220 VAC, 25VDC with Resistive Load 8 A 

@ 220 VAC, 25VDC with Inductive Load (P.F=0.4, L/R=7 mS)  

 Contact Material AgCdO 

 Max. Operating Voltage 380 VAC, 125 VDC 

 Max. Switching Capacity 4,000 VA, 480W with Resistive Load 2,000 VA, 

240W with Inductive Load (P.F=0.4)  

 Min. Permissible Load 100 mA, 5 VDC 

 Power Consumption 5V @ 200mA 

 15Amp Fuse 380 VAC, 125 VDC 

 Communications cable - RJ-45 jack to sensor using UTP Cat 5 wire.  

 Sensor type - open/closed contact switch  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the Sensor Controlled 

Relay 
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 Up to 2 Sensor Controlled Relays on the sensorProbe2 and 8 on 

sensorProbe8  

 Full autosense including disconnect alarm  

 Metal Oxide Varistors (MOVs) and snubber circuit protect the open 

contacts of the relays from high voltage spike.  

 4 LEDs indicate the status of the Relay, Power Supply, AC Line Voltage 

and AC Load Voltage.  

 Dimensions 65(W) x 62(H) x 15(D) mm 

 Operating Temperature -40°C to 85°C  

 

 

Configuring the Sensor Controlled Relay 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the Sensor Controlled Relay. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 

 

Note: Before going further, it is recommended that you read the Relay Operation 

topic. 

 

Voltage Present at Relay Output : The value in this field is either "Yes" or "No". 

 This field displays whether there is voltage presence at the outlet side of the 

Sensor Controlled Relay.  This field is intended to used when the relay is turned 

on.  If there is voltage at the outlet, Yes is displayed; otherwise, No is displayed 

with a red background.  This indicates that voltage is expected, but it is absent. 

 When the relay is turned off, the word No is always displayed on this field 

without a red-colored background. 

 



sensorProbe 

60 

Relay Status : The Relay Status field shows the current status of the Sensor 

Controlled Relay.  The text on this field can be customized by configuring the 

"Description of Status When Relay On" field for when the relay state is on and 

the "Description of Status When Relay Off" field for the other relay state.  By 

default, either "On" or "Off" is displayed on this field. 

 

Description of Status When Relay On : This field is the custom description, 

which will be displayed in the Relay Status field when the relay state is on.  The 

same text is listed as one of the relay actions used to turn on the relay. 

 Examples for this field are Open Door, Turn Pump On, Turn Light On, etc 

 

Description of Status When Relay Off : This field is the custom description, 

which will be displayed in the Relay Status field when the relay state is off.  The 

same text is listed as one of the relay actions used to turn off the relay. 

 Examples for this field are Close Door, Turn Pump Off, Turn Light Off, etc. 

 

Manual Relay Control 

This section describes parameters that users can configure the Sensor 

Controlled Relay to operate manually. 

 

Relay State : By default, there are five options in this list box: "Allow Sensor to 

Control", "Cycle Turn On-Turn Off-Turn On", "Cycle Turn Off-Turn On-Turn Off", 

"Turn On", and "Turn Off".  Note that "Turn On" and "Turn Off" can be changed 

to custom text by configuring "Description of Status When Relay On" and 

"Description of Status When Relay Off" fields.  Select one of the choices from the 

list box and press the Save button to implement the change. 

 

Cycle Time : This is the number of seconds that the relay is driven when either 

one of Cycle options is selected in the Relay State field.  Enter a number from 1 

to 255 and press the Save button to implement the change. 
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Sensor Relay Control 

Sensors Controlled Relay: By pressing the View button, it opens the "Sensors 

Controlled Relay Detail" page.  The description, relay status, online status, and 

"Sensor Normal Relay State" of this Sensor Controlled Relay are displayed as 

well as a list of all sensors that are configured to control the relay.  The 

information provided for each sensor in the list are Port Number, Type, 

Description, Relay-Activating Threshold, Relay Action, and Relay Cycle Time. 

 

Sensor Normal Relay State : Use the single choice list box to pick either "Turn 

On" or "Turn Off".  Note that "Turn On" and "Turn Off" can be changed to custom 

text by configuring "Description of Status When Relay On" and "Description of 

Status When Relay Off" fields.  Press the Save button at the bottom of the page 

to implement your choice. 
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Smoke Detector 

An important addition to security and safety. These smoke detectors are easy to 

install and configure. The smoke detector must be mounted on the ceiling for 

maximum smoke detection. 

 

The value of the Status for the OID for switch sensors can be Normal, No Status, 

Critical or sensorError. 

 

A popular OID for Smoke Detector Sensors is the status. For RJ45#1 it is 

OID .1.3.6.1.4.1.3854.1.2.2.1.18.1.3.0 
 

Features:  

 On/Off alarm signal of Smoke Detected  

 Accurate, cost effective Smoke Detector 

 LED indicates the status of Smoke Detector  

 Sensor type - open/closed contact switch   

 Up to 2 Smoke Detector Sensors per sensorProbe2, and 8 per 

sensorProbe8 

 Power source: powered by the sensorProbe.  No additional power 

(battery) needed.  

 Includes disconnect alarm that checks that the sensor is securely plugged 

into the sensorProbe 

 

Configuring the Smoke Detector 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the Smoke Detector. 
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For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the installing and 

Configuring Sensors page. 

 

Status : If the sensor is offline the status is No Status. If the sensor is online and 

there is no Smoke detected, the status is Normal. If Smoke is detected then the 

status is Critical. If at any time communications with the Smoke Detector are lost, 

the status of the Smoke Detector is changed to sensorError. 

   

When a smoke detector is connected, the sensorProbe will sense it as dry-

contact sensor. The user can change the description to a Smoke Detector. 

 

The Web interface settings for the smoke detector are: 

Direction :  Input 

Normal State :  Open/+5 Volts   

Output Level :  Low/GND 
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Motion Detector 

The motion detector is housed in an attractive wall mountable unit and easily 
added to your sensorProbe network to provide security for any building.  
 

A popular OID for Motion Detector Sensors is the status. For RJ45#1 it is 

OID .1.3.6.1.4.1.3854.1.2.2.1.18.1.3.0 
 
Features:  

 On/Off alarm signal of Motion detected  

 Accurate, cost effective motion detecting 

 LED in housing indicates movement sensed   

 Electronics are mounted in attractive, angle adjustable wall mountable unit  

 Sensor type - open/closed contact switch  

 Power source: powered by the sensorProbe. No additional power needed.  

 The sensorProbe auto detects the presence of the Motion Detector 

 Up to 2 Motion Detector Sensors per sensorProbe2 and 8 per 

sensorProbe8  

 Includes disconnect alarm that checks that the sensor is securely plugged 

into the sensorProbe 

 

Configuring the Motion detector sensor 

 

Since all of AKCP's intelligent sensors are configured similarly, not every field is 

described below. The descriptions below describe the fields which are special to 

the Motion Detector. 

 

For a general description about configuring all sensors including information 

regarding common configuration parameters, please see the Installing and 

Configuring Sensors page. 
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Status : If the sensor is offline the status is No Status. If the sensor is online and 

there is no motion detected, the status is Normal. If motion is detected then the 

status is Critical. If at any time communications with the Motion Detector are lost, 

the status of the Motion Detector is changed to sensorError. 

 

 



sensorProbe 

66 

External Sensor Integration 

sensorProbe external sensor integration allows the user to integrate a custom 

sensor to the sensorProbe while still retaining all of the features of the standard 

sensors. This interface has the full range of functionality including snmp 

integration, email and trap generations with adjustable limits and thresholds.  

 

Customers have added pressure transducers, Solar Power Monitors, Battery 

Monitors, and have integrated the sensorProbe into laboratory test equipment. 

For plant nurseries, hospitals and many other applications are possible where 

monitoring is essential. 

 

This interface can be used by OEMs and engineers to create their own custom 

data collection systems. The user can configure sensor input voltage range from 

0 to 60 or -60 to 0 volts through the addition of the DC Voltage sensor directly 

into the sensorProbe if the transducers voltage does not exceed 5 volts. 

 

Readings are available in both raw data and as an absolute values or a 

percentage of full scale. Full scale is user programmable with both the base and 

top voltage from 0 to 60 volts. SNMP interface for alarm/normal status. SNMP 

traps sent when status changes. SNMP polling via get is available. Web browser 

interface is also available. When an alarm condition is activated the status and 

location of the fault can be sent via email.  

 

All data values from the sensor are graphed overtime using internal memory of 

the sensorProbe. 

 

For more information on setting up a configuring an external sensor sees the 

page describing the DC Voltage Sensor. 
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Integration with Network 
Management System 
Integration with Network Management Systems 

 
The sensorProbe is embedded with full SNMP and can integrate with any SNMP 

based network management systems, such as HP OpenView NNM, IPSwitch 

WhatsUp Gold, CA Unicenter TNG, Tivoli, Compaq Insight Manager etc. The 

sensorProbe comes with a MIB file which can be easily loaded to your network 

management system and can receive SNMP alerts. 

 

By default the traps are for WhatsUp Gold style.  The user can change the traps 

to HP OpenView NNM or to WhatsUp Gold or both by using the command: 

 

snmpset <IP> <community>  .1.3.6.1.4.1.3854.1.2.2.1.60.0 i <x> 

 

Where <IP> is the IP address of the sensorProbe. Community default is "public". 

and <x> can take 3 values: 1 (WhatsUp Gold style), 2 (HP OpenView Style), 

3(both Style). By default, the X value set is 1. 

 

 

HP OpenView 

 

WhatsUP Gold 

 

Others 
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HP OpenView 

Loading the MIB to NNM 

From the NNM menu press Options > Load / Unload MIBs: SNMP. The dialog 

box for Loading / Unloading mibs appears. Press Load.  Browse to the MIB file of 

the sensorProbe. The file name is sp.mib, and it is included in a companion CD 

at \akcp_utilities\mib.  Press Open to load this MIB. Press OK to load the Trap 

definitions. 
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NNM Menu Integration 

Adding sensorProbe to the NNM Menu 

You can easily integrate sensorProbe into the NNM menu. You can add 

graphing, the Web Based Monitor Application (Web Based User Interface), online 

web based documentation to the NNM Menu. This enhancement is optional but it 

adds a number of important features.  

 

Because the Web based user interface and documentation are web based they 

can be used on any platform such as an HP-UX box or a Sun or other UNIX 

system. By adding the Web based user interface to the NNM menu it becomes 

easy for the user to interact with the SNMP agent, regardless of his location or 

platform.  

 

The NNM menu is also enhanced to add graphing. The user can graph all of the 

temperature or humidity values for every sensorProbe, for example.  Whenever 

the user wants to observe temperature trends across the enterprise, he can do it 

with a single button.  

 

An Application Registration File or ARF file is used by HP OpenView to 

customize and integrate third party applications such as the sensorProbe into 

NNM. The name of this file is called sp2.arf for sensorProbe2 and sp8.arf for 

sensorProbe8.  The sample ARF file is located in the companion CD that you 

received when purchasing the sensorProbe.  It is in a "\akcp_utilities\Openview\" 

directory.  The file in this directory is only an example; hence, you will need to 

modify it to the way you would like it to work.  For example, adding menu for 

graphing temperature sensor, and adding menu to access the web based user 

interface.  Please consult the HP OpenView Documentation on how to create 

and using registration files. 
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In order to integrate this ARF file into NNM you must copy the file to the proper 

directory so that NNM can find it when it starts. In the simplest case of a 

Windows PC running NNM that directory might be C:\HP 

OpenView\registration\C. This path would vary depending upon your choices 

during installation of NNM.  On a UNIX platform the path to copy ARF to would 

be $OV_REGISTRATION/$LANG. In most cases $LANG would be C. The C 

would indicate that the English language is being used. You will find other 

registration files in that directory such as ovw, ovweb, and nnm.  

 

After you have copied ARF to the correct directory you must restart NNM. When 

NNM restarts you should see sensorProbe on the NNM menu. Under 

sensorProbe you should find the menu picks to launch the Web user interface, 

graph temperature sensor, and the status depending on what you customize in 

the ARF file.  

 

The ARF file can also be customized with a standard text editor. You may wish to 

include graphs of humidity sensors or switches. In addition any sensor status can 

be visually graphed.  
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Polling SNMP, Thresholds and Alarm 

NNM can read the Status field to determine if any of the sensors has a problem. 

Polling is the most effective method of monitoring because if network connectivity 

is lost, polling will reveal this failure. While the sensorProbe does send traps 

there is no guarantee that a trap will be delivered to the monitoring station.  

 

The network traffic generated by polling is very limited. The temperature sensor 

need only be read once every five minutes or more depending on your needs.  

 

Setting Up Polling  

 

To setup polling go to the NNM toolbar and click Options > Data Collection & 

Thresholds: SNMP  

The dialog box appears. Click Edit > MIB Object > New  

 

The dialog to pick the OID to monitor appears.  Click on the + to expand the 

private tree. Then expand enterprises > AKCP > sensorProbe. This exposes the 

sensorProbe mib.  

You can monitor the status of an individual sensor by choosing the status OID for 

that sensor.  For example, sensorProbeTempStatus for the status of temperature 

sensor. 

 

A second dialog appears allowing you to further refine the details of what you 

wish to poll. On the "Set Collection Mode", select "Store, Check Thresholds". 

 Enter the IP Address of the sensorProbe in the Source field.  Press Add to add 

that data source to the list of nodes to be monitored.  

 

Next you can change the polling interval. For now we will enter 5s. This will 

cause the node to be polled every 5 seconds. This is to often for a working 
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environment. However it will help to test the sensorProbe if we poll more often. 

Once testing is complete we can set the polling to a larger interval.  

 

Set the Threshold Parameters to >= 3. This means that we will cause an alarm to 

be triggered whenever the status is greater than or equal to 3. When the status is 

equal to 3 this means that the status of one of the sensors is at warning.  

 

Set the Rearm value to < 3. When the status is at 2 then the sensors are at or 

below normal status. When the status is at 1 then the sensors status is 

noStatus. The noStatus status is set when the sensor is set to offline.  

 

Set the Consecutive Samples to 1 for both the Threshold and The Rearm 

sections. Set the Rearm Value Type to Absolute. Press OK to add this MIB 

Object to the collection list and return to the main dialog.  

 

In order for this new collection to become effective you must save it. From the 

dialog menu, click File > Save. You are now polling the sensor Status  
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Traps in NNM 

The sensorProbe sends traps whenever their status changes. These traps are 

defined in the file sp.mib. To act upon these traps open the Event Configuration 

dialog box under the Options menu of NNM (Options > Event Configuration). 

When the Event Configuration dialog box loads, scroll down the top box until you 

can select sensorProbe. The bottom list box will now list the traps available using 

sensorProbe. Select a trap from the bottom list and then from the Dialog menu 

click Edit > Events > Modify. The Modify Events dialog box appears. Press Event 

Messages and then press Log and display in category:. Choose Application Alert 

Alarms. Now press Actions.  

 

You may enter a message under the popup window entry. You can include in the 

message variable binding information if the trap comes from the sensorProbe. To 

include variable binding information use $1 $2 $3 $4 $5 $6 in your message. 

These macros are defined here.  The variable binding information are described 

in the Description tab.  For example, entering "$6 is $2, status is now $1" will 

display "Temperature1 Description is 77, status is now normal". 

 

You can now close this dialog box and go back to the Event Configuration dialog 

box. Under the File menu choose Save. Now you will see the traps in the 

Application Alert Alarm Browser and the All Alarms Browser. 
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Graphing with NNM 

The easiest way to graph is with utility xnmgraph. From a DOS command 

prompt enter:  

 

You can graph an individual temperature sensor on the sensorProbe.  

 

To graph the first temperature sensor on the sensorProbe hostname 10.1.1.7 

enter:  

xnmgraph -mib ".1.3.6.1.4.1.3854.1.2.2.1.16.1.3::0::::::" 10.1.1.7  

To graph the second temperature sensor on the sensorProbe hostname 10.1.1.7 

enter:  

xnmgraph -mib ".1.3.6.1.4.1.3854.1.2.2.1.16.1.3::1::::::" 10.1.1.7  

-------------------------------------------------------------------------------- 

The graph utility xnmgraph does not save its data. When the program exits, all 

data is lost. If you wish to keep long term data you must save it. If you have been 

collecting data, xnmgraph will read it in when it first starts.  

 

To set up data collecting from the NNM menu click Options > Data Collection & 

Thresholds: SNMP. When the Data Collection & Thresholds: SNMP dialog loads 

click Edit > MIB Collection > New. When the Collection dialog box loads Set 

Collection Mode: Store No Thresholds. Enter the Source the IP address of the 

sensorProbe and add it to the Source List. Press OK to finish with this Dialog and 

then press File > Save to start collecting.  
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Using the MIB Browser 

Start the browser by pressing Tools from the NNM menu, then SNMP MIB 

Browser. Enter the Name or Address of the SNMP sensorProbe.  

 

Enter the Community name of the sensorProbe. The community name is often 

set to public.  

Press private to expose the mib tree under the private OID. Then press 

enterprises, AKCP, sensorProbe.  

 

You will probably not use the MIB browser very much. All of the information 

available from the MIB browser is also available from the Web Based Manager. 

The Web Based Manager also contains additional features and is presented in 

an easier to use format.  

 

What to do if the Mib Browser Doesn't Work  

 

The most common cause of failure to communicate with the sensorProbe is the 

use of the wrong community string or the wrong host IP address. If you believe 

that those parameters are correct you can trace the communication using a LAN 

analyzer such as Microsoft's netmon.  

 

If all else fails send email to support@akcpinc.com  
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Testing Alarms in NNM 

The following example tests the first temperature sensor, but the idea is the 

same for the other sensors. The first thing to do is to make sure that the 

temperature sensor is online. Press the link to the Sensors at the top of the page. 

Now press the button at the left labeled Temperature. Then choose the first 

temperature sensor.  

 

If the temperature sensor is plugged into the first RJ-45 sensor port, the 

Autosense will have placed this sensor online. Check to see if the sensor is 

online. The Status should be Normal if the temperature is within the thresholds. If 

the Status is sensorError make sure that the temperature sensor is plugged into 

the first RJ-45 sensor port.  

 

While you cannot set the Status directly, you can test the sensor Status.  

 

Setting the HighWarning  

In order to cause an alarm to take place, you will need to set the HighWarning 

near to the current room temperature but high enough so that it can go back to 

normal. The status of the temperature sensor will go to HighWarning when the 

Degree meets or exceeds the HighWarning threshold. The sensor will not go 

back to normal however, until the Degree goes below the HighWarning threshold 

by the Rearm amount. This is done to prevent the status from flickering.  

 

If the room temperature is 72 and the Rearm is 2, then a good choice is to set 

Warning High to 76. To set the HighWarning use the Web Based Manager. 

Enter 76 into the Warning High field and press Save.  
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Changing the Temperature  

In order to change the temperature, warm the sensor by holding it in you hands. 

The sensor is the small black plastic package at the end of the cable. Hold the 

temperature sensor until the Degree starts to rise.  

 

To see the change on the Web Based Manager you must refresh the browser. 

Press the Summary tab. You will see the Degree field begin to change.  

 

Changing the Status  

Press the Summary button in the Select a View box of the Web Based Manager. 

The summary will show the new Degree. When the Degree reaches the 

HighWarning threshold the status of the temperature sensor will change to 

HighWarning.  

 

Verifying Alarms  

When the status changed a number of things happened to notify you of this 

change. A Trap was sent if the sensorProbe was configured to send traps. If 

NNM was polling the Status an Alarm occurred.  

 

If you have set up NNM to receive Traps from the sensorProbe you will see a 

Popup window appear.  

 

If you have set up Polling in NNM verify that an alarm has actually occurred by 

opening the Threshold Alarms Browser or the All Alarms Browser. There should 

be an alarm caused by the polled OID Status going to warning which is the 

integer value of 3.  

 

Resetting the Sensor Status  

The temperature sensor will drift back to room temperature. You can see this 

using the Web Based Manager by pressing the Summary View to refresh the 
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browser. You can also enter a value in the Auto Refresh Browser Interval field. 

This will cause the browser to automatically refresh itself.  

 

You will see the Degree change. When the Degree plus the Rearm amount is 

less than the HighWarning threshold the status of the sensor and the value of the 

Status OID will change back to normal. When this Status changes, you will again 

be notified with a Trap. If NNM was polling the Status, an Alarm will occur.  

 

Resetting Thresholds  

If you changed the NNM polling interval, go back to the NNM Data Collection and 

Threshold dialog and reset the polling interval to 1m.  
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Whats Up Gold 

Monitoring sensorProbe with Whats Up Gold 

 

Setting up the MIB identifier 

WhatsUp Gold provides a command line program named mibextra.exe used to 

update the MIB and the trap information that WhatsUp Gold references. The 

program is located in the directory where WhatsUp Gold is installed. 

 

To run the MIB extractor: at the command prompt,  

 

enter: 

WhatsUp> mibextra directory_name\sp.mib directory_name\rfc1213-mib-ii 

 

Note: if the mib extractor returns “failed to open file” error, the MIB files sp.mib 

has dependencies. 

 

These dependency files are listed in the import section of the MIB file and must 

be provided in the same directory as the MIB file. 

 

Now see next topic Browsing SNMP variables 
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Browsing SNMP variables 

 
The SNMP device needed to be monitored must be created and added to a 

network map, this network map could be the existing one or one newly created. 

 

1. Creating a blank network map 

 

1.1 From the File menu of WhatsUp Gold, select 'New Map Wizard' 

 

1.2 Choose 'Create a blank map' 

Press the Finish button. The network map editor window will come up (see 

Figure 1.) 

 

 

 

                                               Figure 1 Network Map Editor 

 

 

2. Creating and adding an SNMP device to the network map 

 

2.1 Right-click the blank area (the right pane). 
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2.2 Select New Device, and select 'Lanbox'. A'lanbox' icon will appear on the 

map. 

 

3. Configuring the newly created SNMP device 

 

3.1 Double click the icon to open the item properties dialog box. 

 

3.2 On the left pane select General (see Figure 2). 

 

 

 

 

 

                          Figure 2 General Property page 

 

 

 

3.3 Fill out the form. 

 

The descriptions of all fields are described below: 

 

- Display name: this identifies the SNMP device. (i.e. sensorProbe). 
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- Type: this is the device type. (i.e. Lanbox). 

 

- Polling Method: this should be ICMP since sensorProbe supports only this 

polling method. 

 

- Poll using: this could be either Hostname or IP Address. If the IP address of the 

SNMP device was assigned by DHCP server, Hostname would be the suitable 

choice. 

 

- Host name: this could be the host name that can be resolved to an IP address 

of the device, or it could be just the IP address of the sensorProbe . 

 

- IP Address: this must be the IP address of the sensorProbe . 

 

- Info Line1 and Info Line2: information entered in these two fields will be 

included in notification messages such as SMS and email. 

 

3.4 On the left pane, select SNMP. 

 

3.5 Enable SNMP Manageable Device as show in Figure 3. 

 

3.6 Fill out all fields including Read Community, Write Community, and Device 

Object ID. 

The description of those fields is described below: 

 

- Read Community: this is the password used for SNMP read permission for the 

sensorProbe. The default password is public. 

- Write Community: this is the password used for SNMP write permission for the 

sensorProbe. The default password is public. 
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- Device Object ID: this is the SNMP object identifier for the device. This identifier 

is used to access a device and read other SNMP data. The device object ID of 

sensorProbe is 1.3.6.1.4.1.3854.1.2.2.1.1. 

 

3.7 Press the OK button to close the window 

 

 

 

        

                                     Figure 3 SNMP Property page 
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Graphing the values of SNMP variables 

                                     
WhatsUp Gold provides a graphing utility named SNMP Graph. Users could 

select one or more SNMP variables to show a real-time graph of their values, 

Moreover the utility can graph the change between the last and the current value 

of a SNMP variable as well as the average change per second in the values of a 

SNMP variable. 

 
 
1. Launching SNMP Graph utility 
 
1.1 From SNMP browser, right-click a desired SNMP variable to be monitored on 
the right pane of the browser as show in Figure 5. 
 
1.2 Select Monitor to open SNMP Graph (see Figure 6). 
 
 

 
                                                     Figure 5 SNMPbrowser 
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                    Figure 6 SNMP Graph Utility 
 
2. Setting the item graphing options 
 
By default, the utility graphs the change between the last and the current value of 
a SNMP variable. 
The steps below show how to set the utility to graph the reported values of the 
SNMP variable. 
 
2.1 Right-click on the IP address column of the desired SNMP variable as show 
in Figure 6. 
Note: There are four menu items including Add (add another SNMP variable), 
Delete (delete the selected variable), Properties (set graphing options), View 
Values (view the raw data used to generate the graph for the selected SNMP 
variable). 
 
2.2 Select Properties to open Graph Item Properties dialog box. (See Figure 7) 
The description of some interesting properties is described below: 
 
- Host: this is the IP address of the SNMP device. 
- Community Name: this is the password used for SNMP read permission. 
- Item and Instance: both are used to form the OID of the SNMP variable. 
- Absolute values: when it is selected, the utility graphs the reported value of the 
SNMP variable. 
- Auto Scale: when it is selected, the graph scale for the SNMP variable is 
determined by the utility. 
- Allow negative values: when it is selected, the utility allows negative values to 
be graphed. 
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      Figure 7 graph Item properties 
 
 
2.3 Select Absolute values as show in Figure 7. 
 
2.4 Press OK button to apply the setting and close the dialog box. 
 
3. Setting the graph options 
 
3.1 From the Graph menu items of SNMP Graph utility (Figure 6), select 
Properties to open Graph Option dialog box shown in Figure 8. 
 
 

 
Figure 8 graph options dialog box 
 
 
3.2 Set up the properties 
- Set Interval (seconds) to 3. This is the time interval at which the utility gets the 
value of the SNMP variable from the SNMP device. 
- In Vertical group box, set the Maximum to 180. This determines the highest 
value on the x-axis scale. 
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- In Horizontal group box, set maximum to 100 and minimum to 50. The 
Maximum and Minimum determine the highest and lowest value on the y-axis 
scale respectively. 
 
3.3 Press OK to apply the new setting and close the dialog box. 
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Receiving SNMP traps from the sensorProbe  

 
First, users have to configure the sensorProbe to send SNMP traps to the 
machine running WhatsUp Gold. This can be configured through the web 
interface of the sensorProbe. 
 
1. Setting up the sensorProbe to send traps 
 
1.1 Select the Traps Tab to go to the Traps page 
 
1.2 Select Send Traps ON via selection box, enter the Destination IP of the 
WhatsUp Gold Host and enter the Community. Then Press Save.  
 
 
After that do the following steps to set up WhatsUp Gold. 
 
2. Enabling the SNMP Trap Handler 
 
2.1 From the Configure menu of WhatsUp Gold, select Program Options to open 
Program Option dialog box. 
 
2.2 On the left pane of the dialog box, click Event Servers icon. 
 
2.3 On the right pane of the dialog box, select SNMP Trap. 
 
2.4 Press Configure button to open Configure SNMP Trap Server Properties 
dialog box shown in Figure 9. 
 
 
 

 
Figure 9 Configure SNMP Trap Server Properties 
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2.5 Select Listen for messages on port. 
 
2.6 Fill out a listening port number (the default value is the standard SNMP trap 
Port is 162). 
 
2.7 Press OK button on Configure SNMP Trap Server Properties dialog box 
 
2.8 Press OK button on Program Options dialog box. 
 
3. Assigning SNMP trap events to the sensorProbe 
 
3.1 Double click the sensorProbe icon on the network map to open the item 
properties dialog box shown in Figure 2. 
 
3.2 On the left pane, select Events. 
 
3.3 Press Add button located on the right pane. The device event properties 
dialog box will come up (see Figure 10). 
 
 
 

 
 
   Figure 10 Device Event Properties dialog box 
 
 
3.4 From Event Type list box, select SNMP trap. 
 
3.5 From Event list box, select spTemperature1Status 
 
3.6 Press OK button to close the dialog box. 
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3.7 Repeat setup 2.3 to 2.6 to add all spTemperature2Status to 
spTemperature8Status as show in Figure 11. 
 
 

 
 
Figure 11 Trap events assigned to the sensorProbe 
 
 
4. Defining Email notifications 
 
There are several notifications supported by WhatsUp Gold including Beeper, 
Group, Pager, Programs, SMS, SMTPMail, Sound, and WinPopup. The following 
steps guide how to configure SMTPMail.  
 
4.1 From Configure menu of WhatsUp Gold, select Notification Library. 
 
4.2 Select SMTPMail. 
 
4.3 Press New button to open New SMTP Notification dialog box shown in Figure  
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Figure 12 New SMTP Notification dialog box 
 
 
4.4 Filling out the form 
 
- Display Name: it is a unique name to identify the email notification, for example 
"Mail to Admin". 
- Mail Server: it is the IP address of your SMTP server. 
- To: it could be one or more email addresses. Each email address is separated 
by a comma. 
- From: it is an email address which will be the sender of an email notification. 
- Subject: it is the subject of an email notification 
 
Note: notification message variables are usually used in the subject and the body 
field (refer to the WhatsUp Gold documentation for further detail). 
4.5 Press OK button to close the dialog box. 
 
5. Setting up notifications for SMTP trap events 
 
5.1 On the left pane of the item properties dialog box, select Alerts. 
 
5.2 Select Enable alerts and Enable logging. 
 
5.3 Press Add button to open Add Alerts dialog box shown in Figure 13. 
 
5.4 In Notification box, select SMTPMail and Mail to Admin. 
 
5.5 In Trigger box, enter 9999. 
 
5.6 Select Send alert even if console response. 
 
5.7 Select On event. 
 
5.8 Press Select Events button to open Active Event dialog box shown in Figure 
14. 
 
5.9 Select only these specific events listed on this device and activate desired 
trap events by clicking the check box corresponding to them. WhatsUp Gold will 
send a notification when it receives an active trap event. In figure 14, the first 
three events are active. 
Note: a notification will also be sent if the sensorProbe misses the number of 
polls specified in the trigger box. To disable this particular notification, set the 
trigger number to 9999. 
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Figure 13 Add Alerts dialog box 
 
 
 

 
 
Figure 14 Active Events dialog box 
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MRTG 

The sensorProbe is fully compatible with MRTG. You will need to do to download 

and install MRTG and then create a configuration script. The configuration script 

will instruct MRTG how to pull the data from the sensorProbe via SNMP. MRTG 

will then produce an HTML file giving you graphs for daily, weekly, monthly, and 

yearly statistics. 

 

This HTML file can be recreated at periodic intervals by MRTG providing a live, 

up to date graph. Often this HTML file is published by a web server giving the 

latest graphs to the all users in the enterprise. 

 

How do I install MRTG? 

MRTG can be downloaded from http://www.mrtg.org. This site has instructions to 

download MRTG and install it.  MRTG will run both on Linux & Windows 

platforms. 

 

After installation, you need to create a configuration file which will gather 

information from the sensorProbe and plot a graph. Below is a minimal template 

which can be used to gather data from the sensorProbe. 

 

Template: 

/**********************************************/ 

workdir: /www/MRTG 

 

NoMib2: Yes 

 

Target [CONFIG-NAME]: 

1.3.6.1.4.1.3854.1.2.2.1.16.1.3.0&.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.1:public@192.

168.0.205 

MaxBytes[CONFIG-NAME]: 1000 
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Options [CONFIG-NAME]: growright, nopercent, gauge 

Title [CONFIG-NAME]: /*Title to display in the html page*/ 

PageTop [CONFIG-NAME]: /*Page heading */ 

YLegend [CONFIG-NAME]: Deg C / % Hum 

ShortLegend [CONFIG-NAME]: &nbsp 

Legend1 [CONFIG-NAME]: Temperature 

Legend2 [CONFIG-NAME]: Relative Humidity 

LegendI [CONFIG-NAME]: Temperature&nbsp in &deg;C&nbsp 

LegendO [CONFIG-NAME]: Humidity&nbsp in %&nbsp 

 

/**********************************************/ 

 

 

The CONFIG-NAME is the base name for files which will be generated by 

MRTG, when the above script is run. More details on the configuration file syntax 

can be found in the link below: 

http://people.ee.ethz.ch/~oetiker/webtools/mrtg/mrtg-reference.html 

 

You can add more configurations to the above template to customize it for your 

needs. 

 

The above sample gives the graphs for the Temperature Sensor connected to 

port1 and humidity sensor on port2 of the sensorProbe with IP 192.168.0.205 

and community as public. 

 

Below is a list of OID’s for temperature & humidity sensors. To find out an OID 

connected to a particular port, the user has to read the last digits of the OID. In 

the web-interface, the ports are numbered from 1 to 8 and the corresponding OID 

last digits are from 0 to 7. 

 

Temperature OID's: 
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.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.0 #this is the temperature 1 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.1 #this is the temperature 2 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.2 #this is the temperature 3 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.3 #this is the temperature 4 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.4 #this is the temperature 5 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.5 #this is the temperature 6 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.6 #this is the temperature 7 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.7 #this is the temperature 8 

 

Humidity OID's: 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.0 #this is the humidity 1 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.1 #this is the humidity 2 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.2 #this is the humidity 3 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.3 #this is the humidity 4 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.4 #this is the humidity 5 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.5 #this is the humidity 6 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.6 #this is the humidity 7 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.7 #this is the humidity 8 

 

 

To see a demo of MRTG configured to monitor sensorProbe, you can check the 

link: http://61.11.64.164/company/mrtg/  

 

This link also gives you the sample configuration files similar to the above 

template, which is used to gather data from the sensorProbe. 

 

Any sensor producing a graphical data in the sensorProbe can be configured in 

MRTG. For more information on configuring sensorProbe with MRTG and 

clarifications please mail us at support@AKCPinc.com. 
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Sample MRTG Graphs 

`Daily' Graph (5 Minute Average) 

 
 
 
`Weekly' Graph (30 Minute Average) 
 

 
 
 
`Monthly' Graph (2 Hour Average) 
 

 
 
 
`Yearly' Graph (1 Day Average) 
 

 
 
 
 
 
 



SNMP 

97 

 
 
Summary Table:  
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SNMP 

SNMP 
The sensorProbe  is fully compliant with SNMP V1 and has been tested on a 

number of different platforms including Hewlett Packard and their OpenView 

platform, Computer Associates and their TNG platform, Cabletron and their 

Spectrum platform, IBM Tivoli, Veritas, WhatsUp Gold, Microsoft SNMP, as 

well as various UNIX systems including Linux, BSD, and Sun.  

 

The MIB for the sensorProbe is available and is called sp.mib. This MIB can be 

loaded into a MIB browser and used to access the agent.  
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MIB on the sensorProbe 

For a formal definition of a specific OID consult the file sp.mib  

 

You can use standard SNMP tools to access the MIB on the sensorProbe. For 

example, the utility snmputil can be used from the command line of a NT to get 

information from the sensorProbe.  

 

There are also utilities from UCD which we can send upon request. With these 

standard SNMP utilities you can set and get SNMP parameters from a script file.  

 

For example the following line gets the first temperature sensor:  

snmpget 192.168.0.100 public .1.3.6.1.4.1.3854.1.2.2.1.16.1.3.0  

The following line gets the second temperature sensor:  

snmpget 192.168.0.100 public .1.3.6.1.4.1.3854.1.2.2.1.16.1.3.1  

 
 
This programs snmpget.exe and snmpset.exe are located in the folder: 
\\ucd_utilities\ in the help CD provided along with the product. 
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MIB II on the sensorProbe 

MIB-II is a standard MIB which is supported by many manufacturers. This is 

useful because the same OID can be used on different boxes to get standard 

information. For example this information includes how long the box has been 

running, the name of the manufacturer, the system contact, and other 

information.  

 

The settable parameters such as the system contact, the system name, and the 

system location can be set using standard SNMP tools. Once these parameters 

are set, they are saved to EEPROM and are restored whenever the sensorProbe 

reboots. These settable parameters are limited to 35 characters.  

 

Listed below is the MIB-II variables that are supported by the sensorProbe.  

 

sysDescr  

DESCRIPTION "A textual description of the entity. This value should include the 

full name and version identification of the system's hardware type, software 

operating-system, and networking software. It is mandatory that this only 

contains printable ASCII characters." ::= { System 1 } .1.3.6.1.2.1.1.1.0  

 

sysObjectID  

DESCRIPTION "The vendor's authoritative identification of the network 

management subsystem contained in the entity. This value is allocated within the 

SMI enterprises subtree (1.3.6.1.4.1) and provides an easy and unambiguous 

means for determining 'what kind of box' is being managed. For example, if 

vendor 'Flintstones, Inc.' was assigned the subtree 1.3.6.1.4.1.4242, it could 

assign the identifier 1.3.6.1.4.1.4242.1.1 to its 'Fred Router'." ::= { System 2 } 

.1.3.6.1.2.1.1.2.0  
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sysUpTime  

DESCRIPTION "The time (in hundredths of a second) since the network 

management portion of the system was last reinitialized." ::= { System 3 } 

.1.3.6.1.2.1.1.3.0  

 

sysContact  

DESCRIPTION "The textual identification of the contact person for this managed 

node, together with information on how to contact this person." ::= { System 4 } 

.1.3.6.1.2.1.1.4.0  

 

sysName  

DESCRIPTION "An administratively-assigned name for this managed node. By 

convention, this is the node's fully-qualified domain name." ::= { System 5 } 

.1.3.6.1.2.1.1.5.0  

 

sysLocation 

DESCRIPTION "The physical location of this node (e.g., 'telephone closet, 3rd 

floor')." ::= { system 6 } .1.3.6.1.2.1.1.6.0  

 

sysIfNumber  

DESCRIPTION "The Number of Interfaces this device supports" ::= { interfaces 1 

} .1.3.6.1.2.1.2.1.0  

 

sysIfIndex  

DESCRIPTION "Unique Index for this entry" ::= { interfaces 2.1.1 } 

.1.3.6.1.2.1.2.2.1.1.0 
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SNMP Traps 

The implementation of Traps on the sensorProbe is complete and fully featured. 

 Features include a 35 byte description field for every sensor within the 

sensorProbe. This includes a different description field for every possible sensor 

plugged into every possible port.  

 

Every sensor has programmable limits and thresholds. A different trap message 

is sent for each sensor type such as temperature, humidity, switch. The trap 

messages include 6 var bind fields that include the current sensor status 

(normal, highWarning, highCritical, lowWarning, lowCritical, sensorError), 

the current sensor value, the level exceeded, the sensor index, the sensor name, 

the sensor description.  

 

All of the trap information can be included in messages that you format. The 

description of the sensor and its current value are useful in creating meaningful 

messages.  

 

The trap system supports the two trap destinations. 
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Trap thresholds 

The sensorProbe checks the thresholds of each of its alarms once per Trap Poll 

Interval (Twice per Second). The sensorProbe only checks the status of those 

sensors that are online.  
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Trap Var Bind Information 

When the sensorProbe sends traps it uses a different trap for every sensor. For 

example when a temperature sensor trap is sent, an enterprise trap of 6 and a 

specific type of 100 plus the port number of that sensor is used. When the 

humidity trap is sent an enterprise trap of 6 and a specific type of 200 plus the 

port number is used. When the switch trap is sent an enterprise trap of 6 and a 

specific type of 300 plus the port number is used. All of the switch sensors such 

as the water detector, voltage monitor, security sensor share the switch trap.  

 

In a addition to the trap type information, Variable Bind Information is also 

included. Six Var bind fields are attached to the trap. These fields are described 

in order:  

 

1. The status of the sensor. This can be:  

noStatus (1),  

normal (2),  

highWarning (3),  

highCritical (4),  

lowWarning (5),  

lowCritical (6),  

sensorError (7)  

 

2. The sensor value. For a temperature sensor this would be the degree. For a 

humidity sensor this would be the relative humidity. For a switch it would be a 1 

or a 0.  

 

3. Sensor Level Exceeded. The threshold value that was exceeded.  

 

4. Sensor Index. The RJ-45 jack that the sensor is plugged into. This will be 0 or 

1 for RJ-45 1 or 2.  
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5. Sensor Name. For example temperature0, humidity1, water1.  

 

6. Sensor Description. The description that was previously entered into the 

sensorProbe for that sensor.  
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Community String 

By default the community string in "public". This is also the password for the 

User and Administrator. When the Administrator password is changed, that 

new password will become the new community string for SNMP read/write 

operations. If the User password is changed, that new password becomes the 

new community string for SNMP read operations. That means the password for 

Administrator or User can be used as the community string for SNMP read 

operations, and only the Administrator password can be used for the SNMP write 

operations. 
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OID's 

Here you can find the frequently used OID's for the temperature, humidity and 

switch type sensors. To find out an OID connected to a particular port, the user 

has to read the last digits of the OID. In the web interface, the ports are 

numbered from 1 to 8 and the corresponding OID last digits are from 0 to 7. 

 

Temperature OID's: 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.0 #this is the temperature 1 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.1 #this is the temperature 2 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.2 #this is the temperature 3 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.3 #this is the temperature 4 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.4 #this is the temperature 5 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.5 #this is the temperature 6 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.6 #this is the temperature 7 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.3.7 #this is the temperature 8 

 

Humidity OID's: 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.0 #this is the humidity 1 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.1 #this is the humidity 2 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.2 #this is the humidity 3 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.3 #this is the humidity 4 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.4 #this is the humidity 5 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.5 #this is the humidity 6 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.6 #this is the humidity 7 

.1.3.6.1.4.1.3854.1.2.2.1.17.1.3.7 #this is the humidity 8 

 

 

Switch Type sensors: 

 

The type of switch can be found using the following OID's: 
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.1.3.6.1.4.1.3854.1.2.2.1.18.1.9.0   

.1.3.6.1.4.1.3854.1.2.2.1.18.1.9.1  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.9.2  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.9.3  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.9.4  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.9.5  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.9.6  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.9.7  

 

The values of this OID and corresponding sensors are: 

 

Value SensorType 

4 Water 

6 Security 

8 Airflow 

10 Dry Contact 

12 Relay 

13 Voltage 

14  Motion Detector 

 

The switch status can be found out using the follwing OID's: 

 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.0 #this is the switch 1 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.1 #this is the switch 2 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.2 #this is the switch 3 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.3 #this is the switch 4 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.4 #this is the switch 5 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.5 #this is the switch 6 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.6 #this is the switch 7 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.3.7 #this is the switch 8 
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To set a switch output to high: 

The OID's are: 

 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.8.0  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.8.1  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.8.2  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.8.3  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.8.4 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.8.5  

.1.3.6.1.4.1.3854.1.2.2.1.18.1.8.6 

.1.3.6.1.4.1.3854.1.2.2.1.18.1.8.7 

 

This is helpful for remote actuation of a device, when a certain parameter is set. 

 

Example: if a temperature sensor is connected on port 1 and a drycontact cable 

is connected on port 2, and the temperature exceeds threshold, then the 

management software can send an SNMP Set to the drycontact on port 2 with 

the following command: 

 

snmpset 192.168.0.100 public .1.3.6.1.4.1.3854.1.2.2.1.18.1.8.1  i  1 

 

The i denotes an integer value 

i can take 2 values: 1 = output high, 2 = output low 

 

This will make the drycontact pins output a +5V which can turn on a relay. 

 

For other examples, please see the file sp2Init.bat or sp8Init.bat located at 

\\akcp_utilities\ in the help CD. 

For full definitions of all OIDs and their possible values please see the file sp.m    
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Web based User Interface 

Web based User Interface 
The best way to get to know the sensorProbe is through the Web based 

Manager.  

 

Note: Javascript needs to be enabled in the Web Browser for the sensorProbe 

Web Interface to work.   

 

The Web based Manager has a list of functions available by pressing the links 

(tabs) at the top of the web page. The links are described below:  

 

Summary 

Look at the summary view by pressing the Summary tab at the top of the page. 

This section shows the summary status of all the sensors that are online. This 

gives a single page overview of the sensors in the sensorProbe that you have 

placed online.  

 

You can leave your browser on the summary page and set the Auto Refresh 

Browser Interval so that the page continually refreshes itself with the latest 

values.  

 

Sensors 

The Sensors View is used to show and change information for every sensor in 

the sensorProbe. This section allows you to access all the details of the sensor. 

From there you can set the Description, Thresholds, and many other values. 

 

Traps 

The sensorProbe can send SNMP traps to two different trap collectors. You can 

set up the traps using this page.  
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Mail 

You can send email when thresholds for alarms are reached.  

 

System 

The System page displays information for the sensorProbe. From here, you can 

view System Description, System Contact, and System Name, or you can 

change passwords.  

 

Help 

It is a link to this help documentation. 
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Login Page 

The sensorProbe comes with an advanced login feature with two levels of 

password protection. There is a read only user password and a read/write 

administrator password to protect the device configuration. The password 

settings are encrypted and saved into the device to prevent unauthorized access. 

 

Open your web browser, type the IP address of sensorProbe and press Enter, 

the Login Page is then loaded.  The Login page can be disabled by setting the 

Use password field in the System Menu to Off. 

 

Login as User   

The User login allows Users to access the system, but does not allow change of 

settings, but the User can navigate all the pages. 

 

The default "User" password is - "public" 

 

Login as Administrator 

Administrator login gives you all privileges to change the system configurations.  

 

The default "Administrator" password is - "public" 

 

To change the Administrator password, login as "Administrator" with the default 

password, go to "System" menu on the web page, inside the Password Settings 

section, type a new password in both New Admin Password and Confirm New 

Admin Password fields, then click on the "Save" button.  The same steps can 

be applied to change the User password. 

 

You can see the current login status from the top right corner of the web page. 

You can log off the system by clicking on "Log off". 
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Summary Page 

The summary page gives you a convenient single page overview of all the 

sensors that are online. Information on each sensor includes Port, Type, 

Description, Reading, Status, and a plot of variations for sensors that support 

graphing.  The features are explained in detail below. 

 

Auto Refresh (sec.) 

The Summary page can be automatically refreshed after a certain period of time. 

 The refresh rates is set by entering the number of seconds in the Auto Refresh 

(sec.) field, and then click the Start button next to the field.  

 

If the page is rapidly updating, it may be difficult to enter a new value. In that 

case, you should stop the browser from refreshing by pressing the Stop button. 

You can now enter a new refresh rate. To disable auto-refresh, enter 0 for the 

refresh rate, and press the Summary tab at the top of the page.  

 

Port : This is where the Autosense RJ45 sensor port number, which the sensor 

is plugged into, is shown. 

 

Type : This field shows the type of sensor, i.e. temperature, humidity, security, 

etc. The cameraProbe8 can auto detect any AKCP intelligent sensors, and this 

field will be updated accordingly. 

 

Description : This field displays what has been typed into the Description field 

on the Sensor Settings page, along with the description you may enter the 

location of the sensor. 

 

Hint : For a shortcut to configure the sensor, click on the description of the 

sensor.  This will take you to the setting page for that sensor. 
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Reading : This field displays the current sensor reading. 

 

Status : This field displays the status of each sensor plugged into the 

cameraProbe8. The Status may be Normal, Warning, Critical, or Not Plugged In. 

 

View : Every temperature, humidity, DC Voltage, and Airflow sensor can be 

graphed simultaneously. To view their graph, click on "View" next to the sensor.  

 

Sys Log :  This field displays the status of every event that occurred and the 

date and time. Sys Log provides a record of the events generated by the device. 

You can navigate using the Previous, Next, Oldest, and Newest buttons to review 

the events. The Sys Log can also be linked to a remote Sys Log receiver. 
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Sensors setting 

 
This page is used for setting the sensor properties.  For a general description 

about configuring all sensors including information regarding common 

configuration parameters please see the Installing and Configuring Sensors 

page. 
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Graphing 

The graphing capabilities of the sensorProbe are designed for functionality.  They 

are simple and easy to use. However if greater flexibility is desired you should 

consider the use of third party graphing tools. AKCP has written a data capture 

utility included at no extra charge on the CD ROM provided with the system. This 

utility records the value of a sensor on a host system. It is then possible to use a 

large number of third party tools to graph this data.  

 

How Much Data Can be Graphed? 

The sensorProbe has enough memory to save 8,640 data points for each sensor. 

If data is recorded every 15 minutes, there is enough data to display 

measurements for 90 days. If the recording is made every minute, there is 

enough memory to hold data for 6 days.  

 

Note: Whenever power is recycled the data logging is reinitialized and all 

previous data is lost.  

Whenever a sensor is taken off-line and then placed back online the data logging 

is reinitialized and all previous data is lost.  

 

High and Low Values 

The High value and the Low value for every period are displayed. If the sensor is 

removed and a sensorError is observed, then no value will be recorded at that 

time.  

 

Time Accuracy  

The time is determined by a battery backed clock in the sensorProbe. 
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Data averaging  

The data recorded is the average for the high and low value during that period. 

The data is clipped at 0 and 100. Any value over 100 will display as 100. Any 

value less than 0 will display as 0.  

 

Zoom  

There is too much data to display all of it on a single page. Therefore, the data is 

averaged before being shown. When you click on a time to zoom in, all data for 

that period of time is displayed.  
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Traps Setting 

The sensorProbe can send a trap message to two different hosts. Whenever the 

status changes for a sensor that is online, a trap message can be sent. 

 

A different trap message is sent for each sensor type such as temperature, 

humidity, and switch. The trap messages include 6 var bind fields that include the 

current sensor status (Normal, Critical High, Warning High, Critical Low, Warning 

Low, and sensorError), the current sensor value, and the level exceeded, the 

sensor index, the sensor name, and the sensor description.   

 

If trap is not needed, it should be turned off. This will reduce network traffic and 

allow the sensorProbe to operate faster. If you do not need it, we suggest that 

you disable the traps resend feature. 

 

To configure Traps click the tab at the top of the web page labeled Traps.  

 

Send Trap : Turn Traps on or off with this choice. This option is used to control 

both traps for sensors and the Keep Alive trap.  Use the list box to pick either On 

or Off. Press the Save button to implement your choice.  

 

Destination IP : This is the IP address of the destination host that will collect this 

trap. 

 

Community : This is  the Community of the host that will receive this trap. This is 

often set to public.  

 

Send Keep Alive Trap : This is to enable the sensorProbe to send a keep alive 

trap indicating that the sensorProbe is still working properly.  The keep alive trap, 

when enabled, is sent regardless of the sensor status on the sensorProbe.  This 

option is useful when the measured environment is in normal state for such a 
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long time that you may be wonder whether the environment is good or the 

sensorProbe has stopped from functioning.  When enabled, the keep alive trap 

will be periodically sent out. 

 

Keep Alive Trap Resend Interval (mins) : You can set the period between each 

keep alive trap to be sent.  The minimum period is 1 minute. 

 

Resend Warning and Error Traps : You can choose to have traps resent on a 

periodic interval. This may be a good idea because trap messages are not 

guaranteed to be delivered. Traps are based on the UDP communications 

protocol. Each packet is transmitted, but there is no check to see if they were lost 

or garbled. 

 

Resend Interval (seconds) : You can set the period between which a warning 

or error trap messages will be re-transmitted. The minimum period is 10 seconds. 
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Mail Setting 

The sensorProbe can send email to any SMTP server whenever the status 

changes for a sensor that is online. 

 

If email is not needed, it should be turned off. This will reduce network traffic and 

allow the sensorProbe to operate faster. If you do not need it, we suggest that 

you disable the email resend feature. 

 

To configure email click the tab at the top of the web page labeled Mail.  

 

Send Mail : Turn Mail on or off. Use the list box to pick either On or Off. Press 

the Save button to implement your choice.  

 

SMTP Server IP Address:  This is the IP address of the SMTP server. 

 

SMTP Authentication: Turn SMTP authentication on or off with this choice. Use 

the list box to pick either Enable or Disable. 

 

SMTP Server Login Name: Enter a login name for SMTP authentication in this 

field. 

 

SMTP Server Password: Enter a password for SMTP authentication in this field. 

 

Timeout (in seconds from 10 to 30) : You can increase the timeout for SMTP 

server that have poor connectivity. It is best to leave this number as low as 

possible while still allowing for communication to the SMTP server to continue.  

 

Resend Interval (secs) : You can set the period between which a warning or 

error email message will be re-transmitted. 
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Maximum Times to Resend : You can resend the email message a number of 

times by choosing this option. Only warning and error messages are resent. 

 

Mail From : This is the email address of the sender of the email. Due to anti 

spam features of many SMTP servers, the Mail From 'address' must be listed as 

authorized by the SMTP host otherwise you will receive a failure message that 

the host will not relay this message.  

 

Mail Recipient  : The email address of the person that will receive the email. 

This is in the form name@domain.com 

 

Mail Cc1 - Cc5 : You can add up to 5 additional recipients for email. 

 

Test Mail : You can choose to send a test email message when first setting up 

the system, or any time thereafter. Before a test message can be generated, all 

of the necessary information such as the SMTP server, Mail Recipient, and Mail 

From fields must be entered. 

 

Status of the Most Recent Mail : The possible values are "No Status", 

"Success", "Failed".  

 

Last Error Message : This is a debugging aid. If the email is not successfully 

sent, you may find the reason for the problem here. 
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Network Settings 

 
IP Address : You can change the IP address of your sensorProbe using this 

option. Enter the new IP address and click "Save". 

 

Subnet Mask : Set the subnet mask of the device using this option. 

 

Default Gateway : Set the default gateway of the device using this option. 

 

Use DHCP : The sensorProbe can use DHCP to assign its IP address, or can 

use a statically assigned IP address. To use DHCP choose Use DHCP from the 

list box and press set. To stop using DHCP choose Do Not Use DHCP from the 

list box and press set. Statically assigning an IP address also turns off DHCP. 

You can force the sensorProbe to voluntarily give up its IP lease and request a 

new IP lease by choosing Use DHCP from the list box and press set. 

 

Ethernet MAC ID : This is the MAC ID of your sensorProbe. This is a read only 

field.  

 

Ethernet Duplex Mode : This is the Duplex Mode and speed of your 

sensorProbe. This is a read only field. 

 

System Date and Time Settings Section 

RTC Battery Status : This field displays the status of the Real Time Clock 

battery on the sensorProbe.  If the status displays Bad, you must replace the 

battery; otherwise, when the sensorProbe does not have the power (power cord 

is unplugged), the clock will stop running.  Therefore, you must re-configure the 

system time every time the system reboots. 
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Date and Time Settings : Enter the new date and time in this field.  The date 

and time use the following format : date/month/year (dd/mm/yy) and 

hour:minute:second (hh:mm:ss) 

 

Time Zone : Select time zone that is corresponding to your location from this 

listbox. 

 

Use NTP : There are many options in this list box.  The detail for each one is: 

 Do Not Use NTP - select this option to turn off the time synchronization 

feature. 

 One Time - the time is synchronized once the Save button is pressed. 

 On System Start Up - the time is synchronized once the cameraProbe8 is 

turned on or reboot. 

 Once a Month/Week/Day/Hour - the time is automatically synchronized 

every month, week, day, or an hour, respectively. 

 Continuously - the time is automatically synchronized forever. 

 

NTP Server 1 and 2 : Set the IP address of the NTP servers to be used.  The 

NTP will synchronize the time with the server that has less number of the 

stratum. 
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System Page 

System Description : This is a MIB II value set when the microcode for the 

sensorProbe was installed. It includes the build time and version of the 

microcode. This is a read only field.  

Example:  sensorProbe2 SP2216 Nov 13, 2004. or sensorProbe8 SP8239 July 

16, 2004. 

 

System Name, System Location, System Contact : These are MIB II values 

that can be accessed via standard SNMP utilities and often used in management 

platforms to gain information about the sensorProbe. 

 

Use Password : This option enables you to turn on/off the password security, 

disabling this option could allow any user to login to the system and tamper with 

the settings. 

 

Send Debug Messages  : Debug messages can be an aid in determining the 

operation of the sensorProbe. Debug messages are sent to the host that the 

browser is running on, or the host where the SNMP set originated from. To view 

the debug messages use the samon utility with the -no command line input. 

 

Hint : Debug messages should normally be turned off to reduce network traffic.  

 

Data Collection Period (1 to 60 mins) :  This controls how often data is 

collected for use in the graph function.  

 

Display Logo : Turn off displaying the logo by using this option. This option 

should normally be turned off to allow the web pages to be loaded faster.  

   

Password Settings : Use this option to set the new password for "Administrator" 

and "User"   
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Clear Syslog  : Here you can clear the syslog messages for the sensorProbe.  

 

Remote Syslog :  You can set up the sensorProbe to send its syslog message 

in a standard format acceptable to a remote syslog server. For example, the 

Logalot system from Somix. 

 

Remote Syslog IP Address, Remote Syslog Port :  You can set the IP address 

and port of the remote syslog server to which the sensorProbe will send the log 

messages. 
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Help Menu 

The sensorProbe has online help available. Press the Help tab at the top of the 

page, and you will load the help file using the Internet.  

 

This is the same manual as the manual that you are currently viewing. 
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Utilities 

Utilities 
Here you can find various utilities by which you can collect data and do settings 
for the sensorProbe. 
 
AKCP Utilities: 
IPSet 
Data Collect 
 
UCD Utilities: 
SNMP Get 
SNMP Set 
SNMP Walk 
 
MIB File for sensorProbe 
 
Temperature and Humidity OID's 



sensorProbe 

128 

AKCP Utilities 

IP Set 

 

The CD you have received with the sensorProbe comes with a program called 

IPSet.exe. The IPSet.exe program is designed to run on a Microsoft host.  The 

program can operate in two modes: 1) Automatically Get IP and 2) Manually Set 

IP.  The program starts by automatically getting IP as a default operating mode. 

 The program listens for the currently assigned IP and MAC addresses.  The 

sensorProbe broadcasts its IP and MAC address when it is reboot.  Thus, after 

the IPSet.exe is running, cycle the sensorProbe power.  The IPSet.exe then 

receives the broadcasting IP and MAC addresses from the sensorProbe.  When 

the addresses appear in the window, you can press the green Setup Your 

sensorProbe button on the top; this will open a Quickstart Guide on a web 

browser and let you configure your sensorProbe. 

 

You can select to set IP address manually by changing to "Manually Set IP" 

mode.  Once the program has started enter the MAC address in the section 

labeled "MAC Address". The Mac address can be located on the sticker on the 

sensorProbe. Next enter the IP address that you wish to assign to the 

sensorProbe. Then press a "Set" button.  

 

IPSet.exe first checks the IP address to see if it already assigned. Next it will 

assign the IP address and then it will check that the address was successfully 

assigned. If all is well, then IPSet.exe will report that the assignment is Complete. 

 And, you can press the green Setup Your sensorProbe button on the top to 

open a Quickstart Guide on a web browser and let you configure your 

sensorProbe. 
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Data Collection 

 

This utility can be used to collect SNMP data from the sensorProbe or other 

SNMP hosts. The program is configured through the use of command line 

options and a text file oid.txt. The output of the data collection is stored in a 

text file. The data output text file name includes the IP address of the host being 

collected. For example, data10.1.1.7.txt is the file name for the data 

collection output when monitoring the sensorProbe with IP address 10.1.1.7. In 

this way, you can collect data from many different hosts in the same directory 

simultaneously. Once the data has been collected, it can be read into a 

spreadsheet program such as Microsoft Excel™. 

 

This utility is located in the folder \akcp_utilities\datacollect in the help 

CD. 

 

Usage 

datacollect -IP x.x.x.x -Pass <community> [-Oid] [-Out] [-v] [-

Poll] 

 

 

-IP x.x.x.x The IP address of the host to collect data from  

-Pass Community The Read Community String  

-Out FileName Optional output filename  

-v Print the version of this software  

-Poll How often to collect data  

 

How to collect data  

Create a file called oid.txt in the same directory as the program 

dataCollect.exe. The file oid.txt contains a list of the oids that you wish to 

collect data for.  If you wish to run multiple data collections from the same 
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directory you can give each input file a different name such as 

oid10.1.1.7.txt. In this case, you will inform dataCollect.exe of the new name 

by using the option 

-Oid nameOfTextFile.  Each line contains one oid. You may have comments 

following the SNMP OID. 

 

A typical line in the oid.txt file could be: 

...1.3.6.1.4.1.3854.1.2.2.1.16.1.3.0 #this is the temperature 1 

 

Start the program dataCollect. A typical command line could be: 

 

datacollect -IP 10.1.1.7 -Pass public -Poll 5 

 

The program dataCollect will print to the screen after every pass of the data 

collection. When you have collected enough data press CTRL-C to stop the 

program from running. 

 

The data output file called for example data10.1.1.7.txt should be copied to a 

new directory for analysis. This is suggested because the next time dataCollect is 

run it will overwrite the output file. 

Read the data output file into excel. MS Excel will load the text input wizard.  You 

should choose Delimited and press Next. You should then choose comma and 

press Finish. 

 

Example 

datacollect -IP 192.168.0.30 -Pass public -Poll 5 
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Data Download 

The program dataDownload.exe can be used to download sensor data from the 

sensorProbe. The output of the data downloaded is stored in a text file.  The data 

output text file name includes the IP address of the host, port number, and 

sensor type being downloaded.  For example, 192.168.0.100_p1_temperature.txt 

is the file name for the data output when downloading the sensor data from IP 

address 192.168.0.100.  Once the program is executed it will download sensor 

data from all sensors connected to the sensorProbe.  The data output that have 

been downloaded can be read into a spreadsheet program such as MS Excel. 

 

This utility is located in the folder \akcp_utilities\datadownload in the help 

CD. 

 
Usage 

dataload <-i sensorProbeIP> <-p password> [-t -o] 

 

-i sensorProbeIP The IP of sensorProbe to download data from. 

-p password The password of the sensorProbe (set or get community). 

-t Use local timezone for timestamp 

-o Overwrite data if files exist. 

-? Display this usage information and exit. 

 

You will be prompted for any required options you did not specify.  A typical 

command line could be: 

dataDownload -i 192.168.0.100 -p public -o 

 
How to download data 

1. Start the program dataDownload.  This program contains many command line 

options.  To learn what these options are you can enter dataDownload -? from 

the DOS prompt. 
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2. The data output file called for example 192.168.0.100_p1_temperature.txt 

should be copied to a new directory for analysis.  The filename contains IP 

address, port number, and a sensor type.  This is suggested because the next 

time dataDownload is run it will append data to the output file. 

 

3. Read the data output file into Excel. Excel will load the text input wizard.  You 

should choose Delimited and press Next. You should then choose comma and 

press Finish. 
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sensorProbe MIB 

SP.MIB 
 

The sensorProbe2, sensorProbe8, sensorProbe8-X20, sensorProbe8-X60, 

sensorProbe8Linux series, and cameraProbe8 all share the same MIB. There 

may be features described in the MIB that only pertain to a specific platform. For 

example, the sensorProbe8-X60 has more dry contact inputs than the 

sensorProbe2. In general there is great consistency throughout the product 

family. 

 

This MIB file is given along with this software to load all the MIB files compatible 

with HP OpenView, CA Unicenter TNG, UC Davis snmp package, Veritas etc. 

 

This file is located in the folder: \akcp_utilities\mib\ in the help CD provided 

along with the product. 
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UCD Utilities 

SNMP Get 

 

This utility is used to collect data from the sensorProbe. The SNMP GET 

operation is used by the SNMP manager applications to retrieve one or more 

values from the managed objects maintained by the SNMP agent. The 

applications will typically do an SNMP GET request by providing the host name 

of the agent, one or more OID's along with the specific instance of the OID. The 

value of OID is printed on the screen. To run this utility we need a supporting dll 

file libsnmp.dll which is located in the same directory as the executable file. 

 

Usage:  

snmpget [options...] <hostname> {<community>} [<objectID> ...]  
 

Options 

UCD-snmp version: 4.1.1 

-h this help message.  

-H  display configuration file directives understood.  

-V display version number.  

-v 1|2c|3 specifies snmp version to use. Version 1 or 2c specific.  

-c <c> set the community name (v1 or v2c) Version 3 specific.  

-Z <B> <T> set the destination engine boots/time for v3 requests.  

-e <E> security engine ID (e.g., 800000020109840301).  

-E <E> context engine ID (e.g., 800000020109840301).  

-n <N> context name (e.g., bridge1).  

-u <U> security name (e.g., bert).  

-l <L> security level (noAuthNoPriv|authNoPriv|authPriv).  

-a <A> authentication protocol (MD5|SHA).  

-A <P> authentication protocol pass phrase.  
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-x <X> privacy protocol (DES).  

-X <P> privacy protocol pass phrase  

General communication options  

-p <P> use port P instead of the default port.  

-T <LAYER> use LAYER for the network layer.(UDP or TCP).  

-t <T> set the request timeout to T.  

-r <R> set the number of retries to R.  

Debugging  

-d dump input/output packets.  

-D all | <TOKEN[,TOKEN,...]>  turn on debugging output for the specified 

TOK s.  

General options  

-m all | <MIBS> use MIBS list instead of the default mib list.  

-M <MIBDIRS> use MIBDIRS as the location to look for mibs.  

-P <MIBOPTS> toggle various defaults controlling mib parsing.  

MIBOPTS values  

   

u: allow the usage of underlines in mib symbols.  

c: disallow the usage of "--" to terminate.  

comments  

   

d: save the descriptions of the mib objects.  

e: Disable mib errors of MIB symbols conflicts.  

w: Enable mib warnings of MIB symbols conflicts.  

W: Enable detailed warnings of MIB symbols.  

conflicts  

   

R: Replace MIB symbols from latest module  

-O <OUTOPTS> Toggle various defaults controlling output display  

OUTOPTS values  
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n: Print oids numerically.  

e: Print enums numerically.  

b: Dont break oid indexes down.  

q: Quick print for easier parsing.  

f: Print full oids on output.  

s: Print only last symbolic element of oid.  

S: Print MIB module-id plus last element.  

-I <INOPTS> Toggle various defaults controlling input parsing: INOPTS values:  

   

R: Do random access to oid labels.  

b: Do best/regex matching to find a MIB node.  

 

Example: 

snmpget -M c:\temp 10.1.1.7 

public.1.3.6.1.4.1.3854.1.2.2.1.16.1.10.0 

 

where: c:\temp is the folder where the mib files(ifmib.txt, ipmib.txt...etc.) are 

located 

10.1.1.7 is the IP address of the sensorProbe 

public is the community name 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.10.0 is the OID 

 

Example output:  

enterprises.3854.1.2.2.1.16.1.10.0 = 20  
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SNMP Set 

 
This utility is used to set the SNMP Objects using the OID's for cameraProbe. 

The SNMP SET operation is used by the management applications and applets 

to modify the value of the managed object. Most of the managed objects will 

have a default value maintained by the agent. But sometimes applications will be 

modifying the data for one or more MIB variables, in which case it will use the 

SNMP SET operation. The new value set is printed on the screen. To run this 

utility we need a supporting dll file libsnmp.dll which is located in the same 

directory as the executable file. 

 

Usage: 

snmpset [options...] <hostname> {<community>} [<objectID> 

<type> <value>...] 

 

 

Options 

UCD-snmp version: 4.1.1 -h this help message.  

-H  display configuration file directives understood.  

-V display version number.  

-v 1|2c|3 specifies snmp version to use. Version 1 or 2c specific.  

-c <c> set the community name (v1 or v2c) Version 3 specific.  

-Z <B> <T> set the destination engine boots/time for v3 requests.  

-e <E> security engine ID (e.g., 800000020109840301).  

-E <E> context engine ID (e.g., 800000020109840301).  

-n <N> context name (e.g., bridge1).  

-u <U> security name (e.g., bert).  

-l <L> security level (noAuthNoPriv|authNoPriv|authPriv).  

-a <A> authentication protocol (MD5|SHA).  
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-A <P> authentication protocol pass phrase.  

-x <X> privacy protocol (DES).  

-X <P> privacy protocol pass phrase  

General communication options  

-p <P> use port P instead of the default port.  

-T <LAYER> use LAYER for the network layer.(UDP or TCP).  

-t <T> set the request timeout to T.  

-r <R> set the number of retries to R.  

Debugging  

-d dump input/output packets.  

-D all | <TOKEN[,TOKEN,...]>  turn on debugging output for the specified 

TOK s.  

General options  

-m all | <MIBS> use MIBS list instead of the default mib list.  

-M <MIBDIRS> use MIBDIRS as the location to look for mibs.  

-P <MIBOPTS> toggle various defaults controlling mib parsing.  

MIBOPTS values  

   

u: allow the usage of underlines in mib symbols.  

c: disallow the usage of "--" to terminate.  

comments  

   

d: save the descriptions of the mib objects.  

e: Disable mib errors of MIB symbols conflicts.  

w: Enable mib warnings of MIB symbols conflicts.  

W: Enable detailed warnings of MIB symbols.  

conflicts  

   

R: Replace MIB symbols from latest module  

-O <OUTOPTS> Toggle various defaults controlling output display  

OUTOPTS values  
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n: Print oids numerically.  

e: Print enums numerically.  

b: Dont break oid indexes down.  

q: Quick print for easier parsing.  

f: Print full oids on output.  

s: Print only last symbolic element of oid.  

S: Print MIB module-id plus last element.  

-I <INOPTS> Toggle various defaults controlling input parsing: INOPTS values:  

   

R: Do random access to oid labels.  

b: Do best/regex matching to find a MIB node.  

type - one of i, u, t, a, o, s, x, d, n  

   

i: INTEGER, u: unsigned INTEGER, t: TIMETICKS, a: IPADDRESS  

o: OBJID, s: STRING, x: HEX STRING, d: DECIMAL STRING  

U: unsigned int64, I: signed int64, F: float, D: double  

 

Example: 

snmpset -M c:/temp 10.1.1.7 public 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.10.0 i 30  

 

where: c:\temp is the folder where the mib files(ifmib.txt,ipmib.txt...etc.) are 

located 

10.1.1.7 is the IP address of the sensorProbe 

public is the community name 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.10.0 is the OID 

i is the data type to be set 30 is the data to be set 

 

Output 

enterprises.3854.1.2.2.1.16.1.10.0 = 30  
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SNMP Walk 

 

This utility fetches the SNMP objects using SNMP GET NEXT from an agent 

specified by the hostname. The values of the next OID are printed on the screen. 

To run this utility we need a supporting dll file libsnmp.dll.  

 

Usage: 

snmpwalk [options...] <hostname> {<community>} [<objectID> ...] 

 

 

Options 

UCD-snmp version: 4.1.1 -h this help message.  

-h this help message.  

-H  display configuration file directives understood.  

-V display version number.  

-v 1|2c|3 specifies snmp version to use. Version 1 or 2c specific.  

-c <c> set the community name (v1 or v2c) Version 3 specific.  

-Z <B> <T> set the destination engine boots/time for v3 requests.  

-e <E> security engine ID (e.g., 800000020109840301).  

-E <E> context engine ID (e.g., 800000020109840301).  

-n <N> context name (e.g., bridge1).  

-u <U> security name (e.g., bert).  

-l <L> security level (noAuthNoPriv|authNoPriv|authPriv).  

-a <A> authentication protocol (MD5|SHA).  

-A <P> authentication protocol pass phrase.  

-x <X> privacy protocol (DES).  

-X <P> privacy protocol pass phrase  

General communication options  

-p <P> use port P instead of the default port.  
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-T <LAYER> use LAYER for the network layer.(UDP or TCP).  

-t <T> set the request timeout to T.  

-r <R> set the number of retries to R.  

Debugging  

-d dump input/output packets.  

-D all | <TOKEN[,TOKEN,...]>  turn on debugging output for the specified 

TOK s.  

General options  

-m all | <MIBS> use MIBS list instead of the default mib list.  

-M <MIBDIRS> use MIBDIRS as the location to look for mibs.  

-P <MIBOPTS> toggle various defaults controlling mib parsing.  

MIBOPTS values  

   

u: allow the usage of underlines in mib symbols.  

c: disallow the usage of "--" to terminate.  

comments  

   

d: save the descriptions of the mib objects.  

e: Disable mib errors of MIB symbols conflicts.  

w: Enable mib warnings of MIB symbols conflicts.  

W: Enable detailed warnings of MIB symbols.  

conflicts  

   

R: Replace MIB symbols from latest module  

-O <OUTOPTS> Toggle various defaults controlling output display  

OUTOPTS values  

   

n: Print oids numerically.  

e: Print enums numerically.  

b: Dont break oid indexes down.  
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q: Quick print for easier parsing.  

f: Print full oids on output.  

s: Print only last symbolic element of oid.  

S: Print MIB module-id plus last element.  

-I <INOPTS> Toggle various defaults controlling input parsing: INOPTS values:  

   

R: Do random access to oid labels.  

b: Do best/regex matching to find a MIB node.  

-C <APPOPTS> Toggle various application specific behaviour:APPOPTS values:  

   

p: Print the number of variables found.  

i: Include the requested OID in the search range.  

 

Example: 

snmpwalk -M c:/temp 10.1.1.7 public 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.10.1 

 

where: c:\temp is the folder where the mib files(ifmib.txt, 

ipmib.txt...etc.) are located 

10.1.1.7 is the IP address of the sensorProbe 

public is the community name 

.1.3.6.1.4.1.3854.1.2.2.1.16.1.10.0 is the OID 

 

Output: 

enterprises.3854.1.2.2.1.16.1.11.0 = 1  
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FAQ's 

 

Q) Why am I unable to set the IP to the device using the IPSet utility 

provided in the help CD? 

Answers:  

a) The power to the sensorProbe may be lost.  Check the red LED.  It should be 

steadily lit. 

b) The device is not hooked up properly with the LAN/network/Patch cable. 

Check the green LED.  It should be steadily lit. 

c) The PC used to configure the sensorProbe is on a different subnet than the 

device. Note: IPSet.exe will not work across routers.  It will work across switches 

and hubs. 

d) Try to connect a crossover cable from a computer directly to the sensorProbe. 

 This is the recommended method to set up the sensorProbe. 

 

Q) What is the default IP of the device? 

Answer: 

a) The default IP assigned at the factory is: 192.168.0.100 

 

Q) If the IPSet fails, is there any other method of assigning the IP address? 

Answer: Yes 

a) Find out the IP address of your network adapter by entering the command  

"ipconfig" at the command prompt. In Windows 2000 and XP the command 

prompt can be accessed by clicking on Start -> Run -> and then typing in ‘cmd’ 

into the dialog box. 

b) Add the IP address of the sensorProbe to the routing table by entering “route 

add 192.168.0.100 x.x.x.x” where x.x.x.x is the IP address of the network adapter  

c) Ping 192.168.0.100.  If the ping works then open up your browser and access 

the web interface of the device by typing the IP 192.168.0.100.  Then, you can 

assign the IP address using the Network page of the web interface. 
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Q) Can I use the default IP of the device to access the web interface and 

later assign the desired IP? 

Answer: 

a) Yes, you can access the web interface by entering the IP 192.168.0.100 in 

your browser. 

 

Q) I’m able to ping the device IP, but I’m not getting the web interface when 

I enter the IP in the browser? 

Answer: 

a) The proxy settings of the browser may be preventing access to the device. 

Please disable the proxy settings to access the web interface. 

b) You have updated the firmware, but you have not updated the HTML code 

update. HTML code updates have to be done, after the firmware update has 

been competed. 

 

Q) Where can I find the MAC address of the device? 

Answer:  

a) The MAC address of the device can be found on the bottom cover of the 

device, and also on the web interface under the System page. 

 

Q) After some days of use, I have changed the IP of the device. But it 

changes to the old IP after a few hours. How can I prevent this? 

Answers: 

a) What is happening is that after the IP address has been changed by the 

user, it is being changed back by a network management program. One way that 

you can change the IP address is to statically set the ARP cache to associate the 

MAC address with the IP address and then ping it. Therefore someone or some 

automated network management program can later come by and ping the old IP 

address and thereby reset the IP address back to the previous value.  
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b) The way to prevent this from happening is to send an SNMP command to the 

device to disallow IP changes to be made. We do not have this command on the 

user interface because once set the IPSet  program can no longer be used to 

change the IP address until an SNMP command is sent to the box to undo this 

setting and allow the IP address to once again be changed.  

      The command to disable the IP change is: 

snmpset  <IP>  <community>  .1.3.6.1.4.1.3854.1.2.2.1.62.0 i X 

 Where IP is the IP address of the device. Community default is "public". and X 

can take 2 values: 1 (enable IP change), 2 (disable IP change). 

Caution: If the user forgets the IP address while this setting is in effect the device 

will be unusable. 

 

Q) Where can I find the "mib" file for the device? 

Answer:   

a) The "mib" file for the device can be found in the help CD, under the directory: 

\akcp_utilities\mib\ 

 

Q) I cannot set the device to send mails? 

Answers: 

a) The SMTP server entered is wrong. 

b) The send mail option is not enabled in the Mail settings page. 

c) The timeout period entered is too low. 

d) The gateway IP is not entered in the network page 

e) The mail from address is not set 

f) The mail server is not responding 

g) The mail from address is not validated in the mail server 

h) The mail server settings prohibit it from accepting connections from the device 

IP 

i) The firewall in the network is preventing the SMTP traffic. 
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Q) I cannot log in to the device. 

Answers: 

a) The password entered is wrong. 

b) The password has been changed by another user. 

 

Q) I’m not able to change the settings in the device. 

Answer: 

a) You have logged into the device as a user. Only an administrator can make 

changes to the settings. 

 

Q) How can I recover a lost password? 

Answer: 

a) You need to contact AKCP at support@akcpinc.com 

 

Q) The device is not able to send Traps 

Answers:  

a) The destination TRAP IP is not set in the TRAP settings page. 

b) The community entered is wrong. 

c) The firewall is blocking the TRAP traffic. 

d) The send Trap option is Off. 

 

Q) I have HP OpenView, but I am not able to receive the Traps. 

Answer: 

a) For changing the Traps to HP OpenView style, you need to send an SNMP 

command to the device given below: 

snmpset <IP> <community>  .1.3.6.1.4.1.3854.1.2.2.1.60.0 i X 

 Where IP is the IP address of the sensorProbe. Community default is "public". 

and X can take 3 values: 1 (WhatsUP gold style), 2 (HP OpenView Style), 3(both 

Style). By default, the X value set is 1. 
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Q) I have assigned the gateway IP, and when I click Save, it reverts back to 

the default IP? 

Answer: 

a) This happens when the device is not able to find the IP entered.  When the IP 

is entered, the device searches for the IP, if it finds it, it will accept the IP entered, 

or else, it will revert back to the default IP. 

 

Q) Is the temperature sensor inbuilt within the sensorProbe? 

Answer: No.  We tried to do that when we first designed the sensorProbe. It is 

much cheaper to have an integrated temperature sensor. That is the purpose of 

the grill on the top of the box. What we found is that there is no way to stop the 

heat from the sensorProbe from affecting the temperature sensor; this affect is 

from 2 to 4 degrees Celsius. What would have been necessary had we 

proceeded with that design would have been to "tune" out the offset by applying 

a fudge factor. The problem is that this fudge factor would have had to change 

depending on the temperature and the operating conditions. So if we add in 

fudge factor for normal room temperatures it would have to change when there 

was a problem with the air conditioning and the ambient temperature was higher. 

Because of all these reasons, we came up with the external sensors, so that the 

measurements done by the sensors are accurate and there is no need for 

calibration. 

 

Q) How can I use sp2Init.bat or sp8Init.bat to initialize all configurations in 

the sensorProbe? 

Answer: The "sp2Init.bat" is for using with sensorProbe2 and the "sp8Init.bat" is 

for using with sensorProbe8.  In this FAQ, we use "sp2Init.bat" as an example. 

 The "sp2Init.bat" is resides on the CD-ROM.  It is in the "ucd_utilities" directory. 

 You can run the batch file directly from the CD-ROM. 

1) Go to the DOS-prompt and change the drive letter to CD-ROM; then, change 

the directory to "ucd_utilities" 

2) Run the sp2Init.bat with the following syntax: 
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> sp2Init <ip_address> <community_string> 

 

where <ip_address> is replaced by the IP Address of the sensorProbe 

and <community_string> is replaced by the Administrator password (the 

default is public) 

Note: During the process, you may see a lot of messages saying "Cannot find 

module ... “Please ignore these alert messages since the batch file is still working 

fine. 

3) Wait until the command prompt is displayed again.  This indicates that the 

initialization has finished. 

 

Q) I own a sensorProbe8-X20 and would like to input voltage to those 20 

extra dry contact switches. What is your recommended voltage value that I 

can put on the dry contact so that I will not burn the system?  

Answer: I assume that you are using an opto-isolated type of the dry contacts 

since there is no need to input voltage to the dry contacts that are configured as 

non-isolated. The dry contacts are designed to have the current on LED in range 

of 5 to 27mA with 680ohm resister connected internally. The input voltage is then 

ranging from 5 to 20Volts. So, the maximum voltage that can be put on the dry 

contact is 20 Volts. This is true for both sensorProbe8-X20 and X60.  

 

Q) OK. If I need to input more than 20 Volts to the dry contacts, what is my 

option to do that? And, what will happen if I put a voltage on the dry 

contact that is configured to be non-isolated?  

Answer:  Assume you want to input 48V to the dry contacts whether it is opto-

isolated or not, you can connect an external resistor at the input pin of the dry 

contacts. This external resistor will be serial to the 680ohm internal resistor. Let's 

allow 10mA current to flow in to the LED of the opto; thus, the external resistor 

value is (48V/10mA) - 680ohm = 4120ohm. A more common value would be 

4.7Kohm.  
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If 4.7K is used, there exist the current of (48V/5380ohm) = 9mA. The power on 

the resistor is about (9mA)^2 * 4.7K = 0.38 watts. Thus, the 0.5 watt resistor 

should be enough. 

To conclude, putting the external resistor at the input pin of the dry contacts will 

help prevent the resistors on the board to burn out even though the circuit is not 

opto-isolated and some voltage is put on the input of the dry contacts.  The 

diagram below is an example of how to connect an external resistor to the input 

of the dry contacts. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



sensorProbe 

150 

Index 
0 
0-60V ............................................ 43 
4 
4-20 mAmp Converters 

Configuring................................ 48 
OID............................................ 48 

4-20 mAmp Converters................. 48 
A 
AC Voltage Detector ..................... 32 
Administrator........... 1, 112, 124, 143 
Administrator login .................. 1, 112 
Advanced Setting.......................... 13 
Airflow Sensor............................... 29 
AKCP Utilities............................ 127 
AKCP_utilities/datacollect ........... 129 
AKCP_utilities/mib ................ 99, 143 
Alerts............................................. 88 
Assigning 

IP 4, 128, 143 
Assigning ........................................ 4 
Assigning .................................... 128 
Assigning .................................... 143 
Auto Refresh............................... 113 
Autosense 

disable....................................... 13 
Autosense....................................... 1 
Autosense..................................... 13 
Autosense..................................... 41 
Autosense..................................... 76 
Autosense RJ45.......................... 113 
C 
Celsius .......................................... 20 
Clear Syslog ............................... 124 
Client's Mac Address .............. 4, 128 
Community 

Enter.................................... 75, 88 
Community.................................... 75 
Community.................................... 88 
Community.................................. 118 
Critical High .................................. 13 
Critical Low ................................... 13 
CriticalHigh,WarningHigh.............. 13 
CriticalLow .................................... 13 

D 
Data Collect Period .....................124 
Data Collection......................74, 129 
DataCollect..................................129 
DC Voltage Sensor........................43 
Delay Before Sending Trap/Email On 

Normal .......................................13 
DHCP 

request.........................................4 
senorProbe ..................................4 

DHCP..............................................4 
DHCP............................................80 
DHCP..........................................122 
Disable Autosense ........................13 
Display Logo ...............................124 
Dry contact inputs 

sensorProbe2 ............................41 
Dry contact inputs..........................41 
Dry Contact Sensor.......................36 
E 
Ethernet......................................3, 4 
Events ...........................................88 
External Sensor Integration...........66 
F 
Fahrenheit .....................................20 
FAQ's ..........................................143 
G 
GoOffline .......................................13 
GoOnline .......................................13 
Graph 

values ........................................84 
Graph ............................................69 
Graph ............................................84 
Graph ..........................................113 
Graph ..........................................116 
H 
Hhmsagent..................69, 71, 73, 75 
I 
IBM Tivoli ..................................1, 98 
IPSet.exe.........................................4 
L 
Login Page ..................................112 
Low Critical..............................43, 48 



Index 

151 

Low Warning........................... 43, 48 
Low/GND ...................................... 62 
M 
Mails/Traps ................................... 13 
MIB-II .......................................... 100 
Motion Detector Sensors .............. 64 
N 
Network Settings......................... 122 
P 
Password Settings ...................... 124 
Port ............................................. 113 
Power Relay Board ....................... 58 
R 
Read/write administrator ............. 112 
Rearm........................................... 13 
Remote Syslog............................ 124 
Resend Interval........................... 118 
Resend Warning ......................... 118 
Resending................................... 118 
RJ 45 .............................................. 3 
S 
Sample MRTG Graphs ................. 96 
SenorProbe..................................... 1 
Sensor Level Exceeded .............. 104 
Sensor Name.............................. 104 
Sensor Status ............................... 76 
SensorError ... 13, 20, 27, 32, 34, 58, 

62, 64, 76, 104, 116, 118 
SensorProbe8-X20 ....................... 36 

SensorProbe8-X20/X60 ................36 
Sensors . 13, 32, 34, 41, 76, 113, 115 
Sensors View .............................110 
Smoke Detector ............................62 
SMS ....................................1, 80, 88 
SNMP Get ...................................134 
Subnet.....................................4, 143 
Summary.....................................113 
Summary View...........................110 
Sys Log .......................................113 
System ........................................112 
System Description...........110, 124 
System Location..................100, 124 
System Name..............100, 110, 124 
System Page ..........3, 110, 124, 143 
T 
Time Settings ..............................124 
Trap thresholds ...........................103 
Trap Var Bind Information ...........104 
Traps Setting...............................118 
U 
User login ....................................112 
Utilities .......................................127 
V 
Variable Bind Information ............104 
View Graph .................................113 
W 
Water Detector ..............................27 

 


	Know Your sensorProbe
	What is sensorProbe?

	Installation
	Assigning a New IP address
	Steps to Assign IP Address

	Quickstart Guide
	Setup Traps
	Setup Mail
	Setup System

	Intelligent Sensors
	Installing and Configuring Sensors
	A/D Converter Calibration
	Temperature Sensor
	Single Port Temperature/Humidity Sensor
	Water Detector
	Airflow Sensor
	AC Voltage Detector
	Security Sensor
	Dry Contact Sensor
	Configuring up to 10 dry contact inputs on the sensorProbe2
	DC Voltage Sensor
	4-20mA Converter
	Relay Operation
	Sensor Controlled Relay
	Smoke Detector
	Motion Detector
	External Sensor Integration

	Integration with Network Management System
	HP OpenView
	Loading the MIB to NNM
	NNM Menu Integration
	Polling SNMP, Thresholds and Alarm
	Traps in NNM
	Graphing with NNM
	Using the MIB Browser
	Testing Alarms in NNM

	Whats Up Gold
	Monitoring sensorProbe with Whats Up Gold
	Browsing SNMP variables
	Graphing the values of SNMP variables
	Receiving SNMP traps from the sensorProbe

	MRTG
	Sample MRTG Graphs


	SNMP
	MIB on the sensorProbe
	MIB II on the sensorProbe
	SNMP Traps
	Trap thresholds
	Trap Var Bind Information
	Community String
	OID's

	Web based User Interface
	Login Page
	Summary Page
	Sensors setting
	Graphing
	Traps Setting
	Mail Setting
	Network Settings
	System Page
	Help Menu

	Utilities
	AKCP Utilities
	IP Set
	Data Collection
	Data Download
	sensorProbe MIB

	UCD Utilities
	SNMP Get
	SNMP Set
	SNMP Walk


	FAQ's
	Index



